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Introduction

AdvoCATE Basic Vision
— To automate the creation, manipulation and management of large-scale assurance cases based on a
formal theory of argument structures

Main purpose
— Creating and manipulating argument structures for safety/assurance cases using the Goal
Structuring Notation (GSN)

— Atest bed and proof-of-concept for the formal theory of argument structures

AdvoCATE is available for
— Windows 7
— Macintosh OS X
— Linux

Eventually, AdvoCATE will
— Serve as a dashboard for safety related information
— Provide an infrastructure for safety decisions and management
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Installation

* Unzip the installation archive into your preferred folder

* Launch the executable file
On launch, specify a path in the workspace launcher dialog box to create a new workspace

8 0O Workspace Launcher

Select a workspace

AdvoCATE stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: [_/Usejs/gpai/gcI_igsg—wqugspa‘ciersi/y\(orlispgc'e{ \1 . Browse...

| | Use this as the default and do not ask again

Cancel | | OK |

A workspace is a folder that AdvoCATE uses to cache tool settings and the state
— Workspaces can be periodically deleted to remove cached settings

AdvoCATE will launch in the AdvoCATE perspective
The AdvoCATE perspective is a customized arrangement of IDE windows which you will use to
create, manipulate and manage argument structures and patterns



AdvoCATE Perspective

- Q' : I v r - . A Quick Access By AdvoCATE
\(5 Project Explorer &3 2% Y= 08 = g
Project Explorer Canvas and Palette panels appear here*

panel
*After creating a new project and adding new arguments / patterns

* Miniature View &£ = 0 @ et 2 Problen Queries _ | Metric Tables [®] Table Preview Verification |11/ Report Specificati LR o

Nothing selected

Miniature View Editing Panels: Detail, Queries, Metrics, Tables, Verification,
panel Report Specification
Status Panels: Problems, Table Preview



AdvoCATE Perspective — Canvas and Palette

Canvas and Palette for Arguments

.= Palette

[f@ Select

r-1
£ Marquee

= Connections
Canvas .
lsSolvedBy
" InContextOf
" HiLink
= Objects
C Goal
R Assumption
) Context
{:} Evidence
£ Justification
L7 Strategy
[i] HiGoal

E HiEvidence
[ Histrategy

Vj: Patterns
List of available patterns —— demopattern1

Canvas and Palette for Patterns

= Palette

[;5 Select

r=1
L Marguee

[=- Connections

— IsSolved By

™ InContextOf

Additional " HiLink
connection #, Choice
= Objects
O Goal
':I"':'Assumptinn

[ Context

{:} Evidence
0 jystification
= Strategy

[ ] HiGoal

E HiEvidence
E Histrategy

 Drag and drop objects and connections from the palette onto the canvas
— The palette for arguments lists available patterns, i.e., a pattern library
— The palette for patterns contains one additional choice connection



AdvoCATE Perspective — Canvas and Palette

Canvas and Palette for Modules and Module Contracts

. Palette b

[+ Select
‘ » The palette contains additional node elements for

= : = module and contract module diagrams
[~ Connections 4
—* |sSolvedBy — Module references

:’: InContextOf — Contract module references
HiLink

r=1
Ll Marguee

Canvas

' [ Objects £

= Goal »  As before, drag and drop objects and
® Assumption connections from the palette onto the canvas
) Context
() Evidence
) Jystification
L7 Strategy
-] AwayGoal
] AwayContext
) AwaySolution

Additional B ModuleRef

Nodes Bl ModuleContractRef

HiGoal
] HiEvidence

[ ] Histrategy
: |~ Patterns

demoPatternl



AdvoCATE Preferences

‘ LU ey File Edit  View  Navigate Search  Project  Run
® O About AdvoCATE AdvoCATE - platform:/res{ource/acUse
- Preferences... 3, e r I =

—J Services >
e ¥ = g
5 . E % a A
o Pre Hide AdvoCATE  %8H |s) demoArgumentl 22
*=Z  Hide Others X 8H
Show All
Quit AdvoCATE  38Q
Preferences
type filter text Advocate =l } v
:E;:;:::Ite ~ General settings for Advocate:
v Bulld : Dialogs
Errors,’Warmngs
¥ Editor Clear all 'do not show again' settings and:show all hidden dialogs. Clear

¥ Attributes
Enumerations
Synonyms
Styles
¥ Formal Taols
AutoCert
Queries
* Help
* Install/Update
»Java
Mission Time
¥ Model Validation
* Run/Debug
¥ Team

> AdVoCATE Preferences

Restore Defaults

Cancel OK

' Advocate - AdvoCATE

File Edit Mavigate Search Project Run [Window | Help
| i - T | Q- | radio | BV Rl New Window
; T - - MNew Editor

[7 Project Explorer 22 it
Open Perspective 4

Show View L

Customize Perspective..
Save Perspective As._
Reset Perspective. .
Close Perspective

Close All Perspectives

Mavigation r

Windows 7

-

 AdvoCATE preferences allow the user to
configure tool settings with respect to

— Errors / Warnings

— Styles of the graphical elements
— Metadata (described later)

— Queries®

— Formal tool integration*

— Other settings elements shown in the
Preferences window are not currently
relevant for AdvoCATE

Preferences

*Not covered in this user guide

AdvoCATE User Guide
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Preferences — Global Errors / Warnings

type filter text

» General
¥ Advocate
¥ Build
Errors /Warnings
¥ Editor
¥ Attributes
Enumerations
Synonyms
Styles
¥ Formal Tools
AutoCert
Queries
¥ Help
¥ Install/Update
¥ Java
Mission Time
» Model Validation
¥ Run/Debug
¥ Team

Preferences

Errors/Warnings =1 .-

Configure Project Specific Settings..

Select the severity level for the following optional problems:
type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off)

= Structure well-formedness check

_—— e = —— = -

Cyclicity :’ Error
Identifier unigeness : Error
Multiple roots : EFDs s s
~ Pattern well-formedness check :
Cyclicity : iB00re s
Identifier unigeness 1 Error
Multiple roots : Warning
WL D X
Default values =
Restore Defaults Apply
_ Cancel | | OK

Note: These preferences apply globally to all
projects in the workspace

* AdvoCATE checks well-formedness upon
saving an argument structure

» Currently, 3 well-formedness checks are
available for arguments and patterns:

— Cyclicity: Presence/absence of
cycles in the structure®

— ldentifier uniqueness: Unique node
identifiers

— Multiple roots: Presence of only a
single root node

« Each check has 3 possible values:
— Error
— Ignore
— Warning

 To alter the defaults, select a value from
the drop-down list

«  Outcomes of the checks are displayed in
the Problems panel

*Cyclic structures are permitted in patterns



Preferences — Project Specific Errors / Warnings

Preferences

type filter text Errors/Warnings v L%
»G |
- A;:::;te Configure Project Specific Settings... ( 1
¥ Build . Select the severity level for the following optional problems:
Errors /Warnings
¥ Editor type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off)
¥ Attributes = Structure well-formedness check
Enumerations Project Specific Configuration
Synonyms Cyclicity
Styles Select the project to configure:
¥ Formal Tools Identifier unigeness
AutoCert : o
fiaries Multiple roots | acUserGuide @ 2 i— . ) :
* Help = Pattern well-Farmedness Properties for acUserGuide (Filtered
¥ Install/Update r
»Java Cyclicity type filter text Errors /Warnings
Mission Time ¥ Advocate
» Model Validation Identifier unigeness Errors/Warnings Enable project specific settings €€ 3
¥ Run/Debug :
» Team Multiple roots Select the severity level for the following optional problems:
type hlter text (use = to filter on preference values, e.g. ~ignore or -aff)
- Structure well-formedness check
Cyclicity Error
Identifier unigeness Error
@) Cancel Ok Mhultiple roots i
g . - Pattern well-formedness check
T Restore Defaults T Apply TR
== C‘f’d“ﬂt\f lgnore
@ | Cancel | OK Identifier unigeness Error
Multiple roots Warning
To override global preferences and configure
project-specific settings
1. Select Configure Project Specific
Settings
2. Select a project from the listed projects
3. By default, project specific settings are
Restore Defaults Apply

disabled

w') Cancel | OK



Preferences — Project Specific Errors / Warnings (Cont'd.)

®NO Properties for acUserGuide (Filtered)
Fype filter text | Errors/Warnings . .-
¥ Advocate
Errors/Warnings  Enable project specific settings << 4

‘ Select the severity level for the following optional problems:

‘ type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off)

w~ Structure well-formedness check

Cyclicity v ;Z‘;:r);ing E 5
Identifier unigeness m
Multiple roots | Error s
B e e e 4. Enable project specific settings by
clici Ignore : .
G o S selecting the check box
ol e 5. Update the default values by selecting a
value from the drop-down list. As in the
global preferences, project-specific well-
formedness checks have 3 possible
values
— Error
— Ignore
— Warning
Restore Defaults Apply
;?' Cancel oK |
: A Note:

These preferences can also be accessed
through Project properties




Preferences — Styles

°
Styles v T
» Ceneral ¢
¥ Advocate Element:
¥ Build ¥ Nodes
Errors /Warnings & Assumption Color: | & 2
¥ Editor 5 AwayContext °
 Attributes =] AwayCoal
Styles ) AwaySolution
P Formal Tools - Choice
Queries _IContext
* Help i Evidence
» Install/Update [JGoal h 1
»Java E-1HiEvidence
» Model Validation ESiHiGoal
* Run/Debug W S reatams
* Team
Restore Defaults Apply
.'j‘:?": Cancel OK
Preference
type fAiter text St}'IGS L4 19
»GCeneral
¥ Advocate Element:
¥ Build » Nodes
Errors /Warnings wLinks Color: | N | €— 2
¥ Editor —+ HiLink "
» Attributes —= InContextOf
Styles = InLink
# Formal Tools —= IsSolvedly 6— 1
Queries = OutLink
*Help
»installfUpdate
* Java
Mission Time
» Model Validation
¥ Run/Debug
B Team

_Restore Defaults _

|  cancel

__Aoply |

OK

AdvoCATE User Guide

Nodes are colored blue by default
Links are colored black by default

To change the default value
1. Select a node / link in the Element
list
2. Then click the Color button to
choose a color



3. Projects
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Overview

» Create an AdvoCATE Project to organize a safety / assurance case

*  Projects can contain

Diagram file types with the extension .argument
» These diagrams can be
— (Non modular) Argument structures
— Module diagrams: An argument structure within a module
— Contract module diagrams: An argument structure within a contract module

Diagram file types with the extension .pattern
« These diagrams are non modular argument patterns

Auto-generated output, e.g., Views, Reports, Metrics
Folders
Other file types referenced by nodes in the argument structure representing
* Documents: e.g., PDF files, MS Word Documents, Text files, etc.
« Parameter values for pattern instantiation, e.g., in CSV files
« Spreadsheets, e.g., MS Excel files
« Web-pages, e.g., HTML files, etc.



Create a New AdvoCATE Project

‘ AdvoCATE m Edit Navigate Search Project Run Window Help

[ Project Explorer &%

Open File...

® Advocate Project

[ Project...
Close #EW L
Close All pRw | = Ff)lder
" File
Save S | Argument Structure
Save As... 7] Argument Pattern
Save All {r88s [ Safety Case Module
Revert =" Safety Case Module Contract
Move... 1 Other...
Rename... F2
21 Refresh F5
Convert Line Delimiters To >
Print... 3EP
Switch Workspace >
Restart
2y Import...
w4 Export...
Properties ®l

‘ AdvoCATE File Edit Navigate Search Project Run Window Help
8enNno AdvoCATE - AdvoCATE - [Use
s Quriralnd me we 3Gl =l

& Advocate Project
T Project...

. Folder
“ File
| Argument Structure
[#] Argument Pattern
i Safety Case Module
— Safety Case Module Contract

77 Other... #EN

AdvoCATE User Guide

N

To create a new project, either
1. Select File > New >

Advocate Project Or
2. Selectthe New icon

Note:

The same steps can be used
also to create new

A. Argument structures

B. Argument patterns

C. Modules

D. Contract modules

17



Create a New AdvoCATE Project

New Project New Project
Project e Project
Create a new project resource. i s/ Create a new project resource.
Project name: myACProject & 1 j Project name: ' myACProject &l A4 j
W Use default location \I, 2 P> | Use default location \I,
Location: /Users/gpai/eclipse-workspaces/workspace/myACProject Browse... | Location: @ /Users/gpai/AdvoCATE/projects/myACProject
Working sets Working sets

|_| Add project to working sets

| Add project to working sets

Browse...

Select...

" Finish

Working sets: : Select... Working sets:
l/?l Cancel | | Finish | l.f?‘:l . Cancel
1. By default the location of a new project is in the workspace.
2. We recommend selecting a different location by unchecking the default location option as
workspaces may need to be periodically deleted
3. Specify a location using the Browse option
4. Then ensure that folder in which the project will be located has the same name as the project



Import an Existing AdvoCATE Project

® AdvoCATE File Edit Navigate Search Project Run

Window

0 . New
| Open File...

| Y

Bt Close
I Project Explorer &% Close All

» =% myACProject
Save

Save As...
Save All
Revert

Move...

Rename...

2 Refresh

Convert Line Delimiters To

Print...

Switch Workspace
Restart

% Export...

Properties

‘ AdvoCATE m Edit Navigate Search Project Run Window
0

ﬂ—>

&N > g:_lvoCA 800

AdvoCA

a o

#EW 3 = S v o
[ Project Explorer 2 = O
0 38W i
» =% myACProject
8S
New >
or3s Show In NRW >
Copy #C
Copy Qualified Name
Fe (= Paste %V
F5 . Delete £33
| 2
1>
#&P w5 Export...
> 2 Refresh F5

£

To import an existing project, either

1. Select File > Import

OR

Load Argument from CSV File
Translate
Translate and Merge

2. Right click the mouse in the Project Explorer and select Import

AdvoCATE User Guide
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Import an Existing AdvoCATE Project

Import B
Import Projects 4 .-«
Select i —X,
“\ Select a directory to search for existing Eclipse projects. {
Create new projects from an archive file or directory. g - 5 l <
(=) Select root directory: | fUsers/gpai/AdvoCATE/projects/acUserGuide v Browse...
Select an import source:
type filter text () Select archive file: v Browse
\ A"
- (ieneral_ _ Projects:
|5, Archive File
|- Existing Projects into Workspace E 3 I v acUserGuide (/Users/apai/AdvoCATE/projects/acUserGuide) Select All
| File System
[ Preferences Deselect All
P = Install
P (= Run/Debug | Refresh
P (= Team
Options
| Search for nested projects
_| Copy projects into workspace b 5
Working sets
| Add project to working sets
Working sets:
:6 < Back Next > Cancel Finish =
. 4 '._'),J < Back Next > Cancel | Finish

Select General > Existing Projects Into Workspace

Specify a path by selecting the Browse button

Select the project(s) to import. We recommend not copying the projects into the workspace as
workspaces may need to be periodically deleted

oA



AdvoCATE Projects

800 . AdvoCATE - AdvoCATE - /Users/gpai/eclipse-workspaces/workspace "
e ' STl (i Q Quick Access l 2| ‘ AdvoCATE
@ Project Explorer X . =& ¥ = 0O 2.8
> (& acuserGuide < New and Imported
R — i > Projects displayed i
Sl rojects displayed in
B Cony o the Project Explorer
Paste EAY P " ACPrOI
* Delete ® AL Zopenes formyatemiact
Move... [ type filter text Errors /Warnings (=T B
Rename... F2 F Resource =
¥ Advocate |_| Enable project specific settings Configure Workspace Settings...
e Import... 2 —_ Errors/Warnings —=
4 Export... Builders Select the severity level for the following optional problems:
= m;&:ﬁt?&:ﬁ;s type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off)
] Refresh S * Structure well-formedness check
Close Project
Close Unrelated Projects Cyclicity Error
Team » Identifier unigeness Error
Compare With > | Multiple roots Error
v Restore f Local History...
5’ Miniature View &3 Czif?grirzom el | > J| Queries Metrics Tables = Pattern well-formedness check
Load Argument from CSV File Cyclicity Ignore
Translate Identifi ? Error
Translate and Merge EETE MR,
- Multiple roots Warning
1 Properties £
ko
l=F myACProject
1. Configure project specific properties by
selecting a project and accessing Properties
on the right-click menu
. . . . | Restore Defaults | |  Apply |
2. Configure available properties as required
@ | Cancel | | oK |

(Also see AdvoCATE Project preferences)

AdvoCATE User Guide
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4. Argument Structures and Patterns

AdvoCATE User Guide
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Create a New Argument Structure

800 . . AdvoCATE - AdvoCATE - /Users/gpai/eclipse-workspi
[ Project Explorer 2. =% Y = 0O
P =% acUserGuide
B New File
T Project..
Go Into Argument Structure \
) [§ File Create a new argument structure file resource.
= Copy #C (5 Folder =
Paste Y e —
€ Delete ® ¥ Argument Pattern Enter or select the parent folder:
Move... Argument Structure 1 myACProject
Rename... F2 5 Safety Case Module
=’ Safety Case Module Contract
3 Import... =% acUserGuide
5 Export... [ Other... #N |=> myACProject
& Refresh F5
Close Project
Close Unrelated Projects
Team >
Compare With > |
~F Miniature vi  Restore from Local History... 3% (% Problems Queries Metrics Tables
Configure >
Load Argument from CSV File
Translate ng selected
Translate and Merge
Properties #l File name: | myArgumentl.argument Pl 2
L e 7
| Advanced >> |

1. Select a project and access the New > Argument
Structure option in the right-click menu* | - .

2. Specify a file name; the file extension is automatically @ = Canonle - [l Fialch

added

* A new argument structure can also be created using the New icon, or the File menu
(See Create a New AdvoCATE Project)

AdvoCATE User Guide 23



New Argument Structure/Pattern

® ' Advocate - platform:/fresourceftest-prolect-2/ha-pattern.acp#0 - AdvoCATE =
File Edit View MNavigate Search Project Run  Window Help
[0 e Q= 37 T e e e | % dh ol | R H| B M| =] &G Quick Access £ | (S Advocate |
[ Project Explorer §2 E%® =08 5| *argument-0 [F] ha-pattern &2 = 0
b = ghsaa-sc = Palette b
4 = test-project s Select

[8 argument-0.acd
4 1= test-project-2
[#] ha-pattern.acp

{_i Marquee

= Connections

" I1sSolvedBy
" InContextOt
~ HiLink
J L L # Choice
Each open structure/pattern is available as a tab, showing the C*Loop
canvas and the corresponding palette T
@ Assumption
O Context
(O Evidence
S Justification
Structures have an “S” in their icon [g e
Patterns have a “P” in 8 AwayCortoc
their icon (& AwaySolution
Ll [ HiNode
[£0 Problems £ | ¢= Tasks ] Properties [l Console ¥ =8
4 items
Description ‘ Resource Path Location Type
4 i Infos (4 items)
(=7 Miniature View £3 = B8 i Build [May 02, 2013 11:02:41 AM] hdb.acp /ghsaa-sc Unknown Advocate Marker
i Build [May 02, 2013 11:02:41 AM] top.acd /gbsaa-sc Unknown Advocate Marker
i Build [May 02, 2013 12:02:55 PM] argument-0_acd Jtest-project Unknown Advocate Marker
i Build [May 02, 2013 12:03:38 PM] ha-pattern.acp Jtest-project-2 Unknown Advocate Marker



New Argument Structure

Drag and drop nodes (objects) and links (connections) from the palette onto the canvas to create an argument structure

i ' Advocate - platform:iresource/test-project/argument-0.acd#/0 - AdvoCATE
File Edit View Navigate Search Project Run Window Help
[G-EHEe R[OS TS [ e el R R S =S 00w - Quick Access & | [ Advwcate )
[ Project Explorer 52 5% T=0 (& *argument-0 i3 | [P] ha-pattern = 0
(=1 ghsaa—sF: ¢ Palette 3
4 [ test-project [+ Select

5] argument-0.acd
4 1= test-project-2
[F] ha-pattern acp

G1
System Alis
acceptably

Creating a node =
shows a text editing

field to enter node
contents

51

Argument of
compliance with
regulations

Selecting a node
dynamically lists its

G2
System A meets
the relevant

regulations

properties in the
Properties panel,
where node contents
can be edited

Problems %] Tasks ' = Properties 13 [El Console
|
Base

~ Properties

£ Miniature View 52 =8 Identifier: E1
Description:

Attributes:

Comment:

C1

Definition of
"acceptably safe”

Regulations have been based
on an identification of the
relevant hazards

Regulatory approval of safety
requires compliance to
relgulations

i Marquee

= Connections <

~* I550lvedBy
~ InContextOf
" HiLink

= Objects ©

1 Goal

@ Assumption
= Context

O Ewvidence

D Justification
7 Strategy

Q AwayGoal
[=] AwayContext
£ AwaySolution
[ Hitode

(= Patterns ©

ha-pattern

A pattern library
lists all patterns

<—— in the current

Caolor: Blue

Urls:
Variables:

[T To Be Instantiated
[T] Public For Modules

Interval Values:

Confidence Variable:

and referenced
projects



New Argument Structure

| [§ *argument-0 &2 | [d] ha-pattern

21 Problems

|

Base

i
Definition of

o Palette [

[ Select

i} Marquee

(= Connections

"acceptably safe” " IsSoledBy
" InContextOf
" HiLink
S1 = Objects 4
Argument of Regulations have been based HlGoal
compliance with on an identification of the G’Assumpt\on
regulations relevant hazards O Context
4 O Evidence
G2 @ Justification
T & Sty
t[z;ii;:i? relgulations Bl AwayGoal
J = AwayContext
(5 AwaySolution
CHiMode
= Patterns £
ha-pattern
) Tasks | = Properties 12 ' Bl Console e Fe= g
- Properties
Identifier: G1
Description: System A is acceptably safe =
Attributes:
Comment:
Color: Blue x
Urls: K
Variables:

[T To Be Instantiated
[#] To Be Developed
[C1Public Far Modules

Interval Values:

Confidence Variable:
[| References Contract

AdvoCATE User Guide

Each node has:

- An auto-generated, but user-editable,
Identifier

- A Description field to enter node
contents

- A Metadata field to enter node-specific
metadata

- User-specified Comments

- A Hyperlinks field to add links to Web
urls

- Checkboxes to decerate annotate
nodes as

- To be instantiated (Only
relevant for patterns)
- To be developed
- Public (Only relevant for Goal,
Context and Evidence nodes to
make them publicly accessible
in external module)
- To Be Supported By Contract
- An Association dropdown menu and
field to indicate whether a node is
associated with another argument

Specifi los | ific additional
fields-

26



Keyboard Shortcuts

Assumption ‘r + WJ
. . l¢- | —
Keyboard shortcuts are an alternative to using the — —
. . . Context Alt + C
palette for rapidly creating simple argument L
structures/patterns. Evidence (Solution) (‘: N E
le-
To use keyboard shortcuts to create an argument Goal N ENE
structure -
1.  Make the canvas active by selecting it Justification - + 1Y
2. Select the appropriate keystroke to create a Strategy . \ﬁ
node - e
3. By default, a text box appears to specify node Away Goal —y i+
contents. - LL ,EM
4. Select the next appropriate keystroke to create Away Context (o) +[ g sm ‘ _|_£C—H
a new node. - S—
5.  AdvoCATE automatically links the two nodes Away Solution G B LR &
with the appropriate link. — —
. Module Reference ‘mt + U@J
6. Use the arrow keys to select the node to which o
the neXt new nOde |S tO be attaChed Module Contract Reference m +/F‘ +@
7. Forexample, [G] [E] [1] [€] creates the following & —
structure Navigation Between Nodes T l ) =
Search o H + H
Select all nodes T
=1+ [




Create a New Argument Pattern

Drag and drop objects (nodes) or connections (links) to create a pattern in the same way as structures

" Advocate - platform:Iresourceltest-project-2/ha-pattern.acp#/0 - AdvoCATE
File Edit View Navigate Search Project Run Window Help
[T5~ B S [T (P57 = [ o o = RO [Zs s alf o 2 S M| = | & &) 100% -~ Quick Access = | [ Advocate |
[ Project Explorer 53 =5 Y= 09 (5] argument-0 [F] *ha-pattern 52 = 0O
4 [ gbsaa-sc o Palette 3
[#] hdb.acp
Select
[8 top.acd ls Selec

4 1= test-project

|8 argument-0 acd
4 1= test-project-2

[F] ha-pattern acp

Select a link to edit its
properties in the
Properties panel in the
same way as nodes

1
Base

~ Properties
Identifier:

To:
Miniature View 52 =5 °
&

From:

[Z] Optional
Multiple
Lower Bound:
Upper Bound:
Link Description:

Cgalpl

Problems §:| Tasks ' EE Properties 53 [l Console

Is Solved By

Goal G2

Strategy S1

#h

G1
System is
acceptably

safe

51
Argument of
hazard
mitigation

G2
Hazard {h =
hazard} is
mitigated

i} Marquee
(&= Connections
~*Is50lvedBy
" InContextOf
" HiLink
# Choice
C*Loop
(&= Objects
B Geal
® Assumption
= Context
() Evidence
2 Justification
L7 Strategy
= AwayGoal

E AwayContext
£ AwaySolution

EHiNode

@

® Y=g

1




Argument Patterns — Choices

To create a choice: e —— —

s M e il i IR T A Has e b [favi] e =8 N e R Quick Accens £ | [F Advecate

1. Select the choice o 7 7T F [ et e X e

¢ 1 test-project
5 argument-0.acd

connection on the p s
palette o
2. Then select the
source node, and
drag to the target
node to create a
choice link (e.g., G1
- S2 as shown) Yl
3. Re-select the |
choice connection
on the palette =
4. Then select the = &
choice () on the
canvas and drag to
the second target
(e.g., ® > S3 as
shown), and so on

nnnnnn

Justihcation



Argument Patterns — Loops

|17 Advocate - platform:/resourceltest-project-2/ehdb-pattern.acp#/0 - AdvoCATE
File Edit View MNavigate Search Project Run Window Help
[ Q= (57 [ = s e e e s o o B i = UL o0 5| [E Adocae)
[ Praject Explorer 53 & Y =0 8] argument-0 |0] ha-pattern [6] *ehdb-pattern 2 = O
= gbsaa-sc % Palette [
4 1= test-project MT

[8 argument-0.acd
a = test-project-2

|#] ehdb-pattern.acp

[8] ha-pattern acp

To create a loop:

1. Select the
IsSolvedBy
connection on
the palette

2. Select the source
node, and drag
to the target
node to create a
loop link (G2 -
S2, as shown)

3. Select the loop
endpoints to
layout the loop
as preferred

=7 Miniature View i3 = Od

G1
Hazard {h =
hazard} is
mitigated
A

53

52

Argument by
Argument over men
BTTTT -o-—__.’. lower level mitigation B
- hazards mech_a_msm {m::
: mitigation}
(|
1
é
1
1
(|
: G2
g Lower-level hazard
F T {hl :- hazard} is
mitigated
N

Problems = Tasks 'ES Properties 23 El Console

"} Marquee

(= Connections 4

" 1sSolvedBy
" InContextOf
" HiLink

* Choice
*Loop

(= Objects @

EGoal

@B Assumption
O Context

O Evidence

& Justification
L7 Strategy

= AwayGoal
= AwayContext
=] AwaySolution
[ElHiNode

= Y=g

|
Base

~ Properties

Identifier: Loop

To: Strategy S2 E]
From: Goal G2 B
[[] Optional

[T Muttiple

Lower Bound:

Upper Bound:

Link Description:

lterations:
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Inserting Patterns from

File Edit View Navigate Search Project n indow  H
RS

[ Project Explorer 5 B%

Patterns can be
added to the
canvas either
through
instantiation (to
be discussed
later) or by
inserting them
directly from the
pattern library.

AdvoCATE
automatically
ensures unique
identifiers by
auto-generating
them.

the Pattern Library

0.acd#/0 - AdvoCATE

=nra)

4 1 test-project-2
[#] ehdb-pattern.acp
[#] ha-pattern.acp

- .|,\<‘;:

[ 0] S o el | ol 2| = W

[8 *argument-0 52 | [8] ha-pattemn [F] ehdb-pattern

G1
System Ais

acceptably
safe

=& a

G2

System A meets

the relevant
regulations

Description: System is acceptably

safe

B
= 8
oo Palette [
[ Select
i1 Marquee
= Connections
" IsSolvedBy
~* InContextOf
 HiLink
(= Objects <
HGoal
® Assumption
O Context

OEvidence

Regulations have been based
on an identification of the
relevant hazards

D Justification

L7 Strategy

QAwayG oal

J BAwayContext
EAwaySo\ut\on
EHiNode

(= Patterns £
ehdb-pattern

Regulatory approval of safety
requires compliance to

1. Select a pattern ;pmem
from the pattern —
library

=]

2. Click the canvas -
at any preferred J

locationtoinsert
the selected

Variables:

[T]To Be Instantiated
[1To Be Developed
[T Public For Modules

pattern



Checking Well-Formedness

|17 Advocate - platfor cell project/ar 0.acd#0 - AdvoCATE =
Eile Edit View MNavigate Search Project Run Window Help
[ mitss SRR A FaE SRS CRe R e N A e Rl A S = B i oo T Quick Access i | (B Advocate |
[ Project Explorer 52 EE& Y = 8  [§ agument0 2 | [f] ha-pattern  [6] ehdb-pattem =5
> = gbsaa-sc < Palette 3
4 1= test-project
Select
[S] argument-0 acd % elec
4 = test-project-2 o1 ] i_{ Marquee
[] ehdb-pattern.acp System Ais | Definition of (= Connections <
[#] ha-pattern acp acce;‘t;'auy "acceptably safe” ™ IsSolvedBy
S
‘ " InContextOf
" HiLink
51 (= Objects @
G3 Argument of Regulations have been based I Goal
System is compliance with on an identification of the @® Assumption
acceptably regulations relevant hazards o
Double click an = A i
O Ewidence
. . D st
error to highlight G2 3 Jusicatin
System A meets equires complance 1o - ststeay
1 s2
it on the canvas —— rlglations B Ay Goal
Argument of regulations § (2 AwayContext
hazard X
mitigation {8 AwaySolution
[ HiNode
(= Patterns &
ehdb-pattemn
ha-pattern
G4
Hazard {h
hazard} is
mitigated
N
Bl Problems 52 5 Tasks roperties & Conscole T =8
Eﬂ Miniature View £% = g 2 errors, 0 wamings, & others
Description ° Resource Path Location Type
a4 @ Emors (2 items)
| @ Multiple root: G1 argument-0.acd Jtest-project Unknown Advocate Marker
@ Multiple root: G3 argument-0.acd Jtest-project Unknown Advocate Marker

i 1 Infos (6 items)

Saving an argument structure/pattern will build it, highlighting errors
and warnings if any




Other Ways to Add Nodes ——

<7 Undo Create Goal

—_—-

= Print...

Another way to add a oy

Paste

node to a diagram is to: Updat

Delete
Layout
- ode Add Assumption
: :
1. Right-click the node. TS

2 . S e I eCt Ad d N Od e ;i.'i:';a;hgattern Qgg ﬁ::;tiilﬁcation

Add Strategy

Yhi

yYvyy

and then any node p————
. Add AwaySolution
choice. For example, e -

Add Node—> Add
Assumption will
automatically add an
Assumption node as
well as the - = s
appropriate link to _._p{ =
the diagram. e s




Other Ways to Add Nodes (Cont.)

G1 N

Another way to add a node to a diagram 2 T
IS to: ?P
opy
Paste
1. Right-click a link that is connecting s
two nodes. i » |
2. Select Insert Node and then the ool i
option of Goal or Strategy nodes bt FROSY | bl N
before or after the link. For example, _Espon Diagram..._ %0 |
selecting Insert Node—> Insert
Strategy before link will produce the
diagram at right. & LLLE L
I"f ~ h\'l
: A




Pattern Instantiation

Instantiating a pattern
involves systematically
replacing its node
parameters with new or
different values. The
AdvoCATE tool uses a
.csv file to specify which
parameters are
replaced and with what
values.

To instantiate a pattern:

1. Open the pattern.

2. Right-click on the

canvas.

Select Instantiate.

4. From your local file
structure, select .csv
file from which to
pull values.

w

&= Print...

Copy
Paste

Update
Delete

Layout
Edit...

« Instantiate
Add Node
Show/Hide...
Hierarchy
Save as Pattern

Export Diagram...

#Fs

#0

B g

/

G1

Regquiremeant 1D {id1
:int} holds

o TR

PN

Argument .-"ll
overlower |
lewal ;

mqu ireme /

D"'/ Ratianale: \‘.
{i1 :: string}
\\“"‘a"“/J

/,f c1
{ [Requirement]
\ {d1 :: string}

N

G2
The werfication {v i
varification} shows
that the requirement
hoids

aN \/
Y

| mrldﬂn{:a}

'|



Pattern Instantiation (cont.) ST ST S| S
# id1 i1 j1 v v e
Rl Froperty & holds
; wer-level property B holds
For example, in the .csv file |61,
|G1, R1.2 Loweryzevel property C holds
shown here: iGl,Rl.E Vi
. pe 54, V1 vi

* Row 1 specifies the node 62,1 Evidenceitemi
. . . |G1, R1.1
Identlfler for nOdeS In iGl.Rl.ll Lower-level property W holds

|G, R1.11
the pattern that have v e
param eters |G2, V2 Evidenceltem2
 Row 2 specifies the
parameter identifiers in
the corresponding nodes
as {variable:type}

* Column 1 shows how the {;l; N
specified node will be naq_u_ir;m.;uz fid1 > Instantiation — | ReduIEment IDRi
instantiated—i.e. it y
specifies the values of Pattern before instantiation Pattern after instantiation

the parameters and the
locations in the instance
where each node is to be
joined



Pattern Instantiation (cont.)

AdvoCATE will automatically open up a
new tab with the instantiated pattern.

The instantiated pattern will also appear
in the project menu on the left as XXX-
instance-1.argument (where XXX is the
name of the original pattern).

The tool features a default auto-layout,
as shown, but can be manually
modified.

Rt
.......

T i sy 2

S



Editing Metadata

Selecting a node
dynamically lists its
properties in the i

[= *argument-demo 2 = 5

Properties panel, where , PO—

61 o o B,
Y Select
System A s f f N

node content—like its i IR Sl | e

| [= Connections £
metadata—can be il
. = ~ InContext of
I e o s — HiLink
e Ite { Regulations have been based \ L
- \ on an identification of the 7 | (== Objects S5
; = relevant hazards i |
A nt of ; o= =C — K [ Geal

' @Assumprinn

n; it} /
regulations !
/ B e = context
| i 2 J _-7“"*\ () Evidence

To add contents to the

Regulatory approval of safety D s
| requires compliance to ) A Justification
ealBlions o 7 strare gy

metad ata fleld In the iﬁtﬂt{%ﬂﬁ:ﬁ P e E:ISD‘ZI
~ E@Epatt:ris:n;q T

node’s Properties panel,

either:

* Create and add
attributes to the node

OR

|_| To Be Instantiated

[Z: Problems [l Properties 3% (9= Parameters - Search W T m

~ Properiies

Identifier: Gl

° Add - t' |_| To Be Developed
eXIS Ing [~ Public
| To Be Supported By Contract

attributes to the node

Associated Argument:




Editing Metadata—Creating Attributes and Parameters

An attribute must already exist for it to be added to a node’s metadata.

To create an attribute and its parameters to add it to a specific node,

1.

2.

3.

Follow the same initial steps as for editing an attribute. Right-click the node. Select
Edit and then Edit Attributes. In the node’s Edit Attributes box, click Add.

If the attribute to be added is not listed in the Attribute Selection box, it must be
created. Click the Attributes link near the top to open the Preferences box.

In the Preferences box, click Add to create an attribute.

Name the attribute. Choose its parameter types by clicking Add and individually
selecting parameters from the list in the Type Selection box . Click Add to add each
parameter to the attribute. Click OK to add the attribute to the Attributes list in the
Preferences box.

In the Preferences box, click Apply and OK. The newly created attribute should
appear in the Attributes Selection box.

Select the attribute to add, click OK, and in the Edit Attributes box, select the
attribute parameters and click OK.

Click OK in the node’s Edit Attributes box. The new attribute should appear in the
node’s metadata.

See the following example for creating an attribute and determining its parameters.



Example: Editing Metadata—Creating Attributes and Parameters

amnn Attribute Selection

An attribute must already exist Nt e R ATt
for it to be added to a node’s e /

@ auto-generated
m etad ata () hazard(String)
" (@) formalizes(Nodeld)
(@ formalizedByiNodel

To create an attribute and its s

(&) usesRequirementiNodeld)

parameters to add it to a o it

specific node, first select the @rarsnonng

node and go to Edit Attributes.

In this case, risk does not vl L

appear in the Attributes —

Selection list, so it must be . =2

YYYYYYYYY Rtk At i :
Created ¥ Build (@ requirementiLevel) | Add.. |
. v Editor auto-generated ==
Attributes (@ hazard(String)

the in Attribute Selection N | e
box. This opens the
Preferences box.

2. In the Preferences box,
click Add.

2 ard Edit
- - - Emilmerauorls (@) formalizes(Nodeld)
1. Select the Attributes link in
ent ar
ion(MNodeld)

( )

)
)

)




Example (cont.): Editing Metadata—Creating Attributes and
Parameters

Name: [isH

3. Name the new attribute— e
in this case, “risk”. Click
Add to open the
parameter Type Selection @ 3 [ ]
DOX.

4. In the Type Selection 80 Type Selction
box, choose each b bl
parameter—Likelihood
and Severity—and click - v N PR

G Likelihood | probable, remote, extremely-remote, extremely-

Add to add each one to
the list of parameters in
the Add Attribute box.

~)
DS
ol
o
s




Example (cont.): Editing Metadata—Creating Attributes and
Parameters

5. When all

Mame: |risk

parameters ol
_Gge:e-ritﬂ catastrophic, hazardous, major, minor }
have been 3 Likelihood { probable, remote, extremely-remote, extremely-i, ..

added to the
Add Attribute
list, click OK.

&

| Cancel |




Example (cont.): Editing Metadata—Creating Attributes and
Parameters

6.

Risk now appears in
the Attribute Selection
list. Select Risk and
click OK.

In the Edit Attributes
box, make the
appropriate parameter
selections. At this
stage, enter the
parameter
characteristics (e.g.
“catastrophic” for the
Severity parameter) if
they do not already
exist. Click OK.

Click OK in the node’s
Edit Attributes box to
add the risk attribute
to the node’s
metadata.

Attributes are defined on the Attributes preference page.

Select an attribute:

@ requirementiLevel)

@ auto-generated

(&) hazard(String)

(@ formalizes(Nodeld)

(@) formalizedBy(Modeld)

(@ Formal

(8) usesAssumpticn{Nodeld)
(@ usesRequirement(Nodeld)
(@) verified By{String)

(@ specifiedIn(String)

18) hasParam{String)

[ hasParam({String, String)
(3) risk{Severity, Likelihood)

(’?ﬂ] | Cancel | | oK |
8™ Edit Attribute

@ riskiSeve rity, Likelihood)

Severity | catastrophic

Likelihood | probable

=

{1] [ cCancel | | oK

7



Metadata—Adding Existing Attributes

Editing

[ a#guments argument

“argumentx ¥

‘dema - i marchas in workspare

Edit Attributes (Goal G1)

Unda Create Goal

.......

aaaaaaaaa

ane

hSahvedhly
||||||||||

HiLink

...............

Attribute Selection

Attributes are defined on the Atiributes preference page.

Select an attribute:

(@ requirement(Level)
(@ hazard(String)

(&) risk{Likelihood, Severity)
(@ formalizes(Nodeld)

@ formalizedBy(Nodeld)

(@) formal

(@ usesAssumption{Nodeld)
(@) usesRequirement(Nodeld)
(@ verifiedBy(String)

(@) specifiedin(String)

)
w

Metadata comprises
attributes, which in turn are
can contain parameters.

To add an attribute from the
library,

1.

Right-click on the node.
From the drop-down
menu, select Edit > Edit
Attributes.

In the Edit Attributes box,
click Add.

In the Attributes Selection
box, select the attribute to
add and click OK. The
added attribute should
appear in the node’s Edit
Attributes box. Click OK.

The attribute will appear in the
metadata field of the node’s
Properties panel.



Example: Edltlng Metadata—Addlng Existing Attributes

Sl Rl S il b

[# *argument-demo 5%

n Bt et |
1 /’— (=1 \
System A is / Daf ition f
acceptabh mmés s sk

)
<7 Undo connection creation B

& Print...
Copy e
g a1 -
Paste aave b based
tification of the
Update 890 cc  nthazards 0

Delete BT
Layout
Edit Attributes
Edit Hyperlinks

Formalize

Verify By... P [és compliance 1o P
3 Add Node p [Eotiatons s
systema  Change Node Type > TT
FeETE  Show/Hide... >
Hierarchy >

Save as Pattern

1 Export Diagram... #®0

—

AN Attribute Selection

Attributes are defined on the Attributes preference page.

Select an attribute:

&N Edit Attributes (Goal G1) @ requirement{Level)
hazard{String)
Attributes: riskiLikelihood, Severity)
| Bl adiaa: (@) formalizes(Nodeld)
(8) formalizedBy(Nodeld)
Edit.. (@) formal
(@) usesAssumption{Nodeld)
usesRequirement(Nodeld)
(8) verified By{String)

2 @) [ Gancel | | (@ specifiediniString)

Remove

Cancel

3 @

AdvoCATE User Guide

For example, to add
Risk as an attribute to
the G1 node,

1. Select G1. Click
Edit and then Edit
Attributes.

2. The node’s Edit
Attributes box
should be empty
because there are
no attributes
associated with
this node. To add,
an attribute, click
Add.

3. Select Risk from
the list of
attributes. The
attribute
parameters for
risk are Likelihood
and Severity.
Click OK.

45



Example (cont.): Editing Metadata—Adding Existing Attributes

Eclit Attribute

(@ riskiLikelihood, Severity)

Likelihood | probable

Severity | c_ata_s_lrap:hic [
4 @) [issetnmehea] Bl es]
ann Edit Attributes (Goal G1)
Attributes:
risk{probable, catastrophic) Add...
Edit.
Rem
5 @ [ cancel | T —

|2 Problems = Properties 52 k= Parameters < Search

W TEm

* Properties
| Identifier: cl
Description: System A is acceptably safe
Metadat,
Commen T

| To Be Developed

6 || Public

In the Edit Attribute box,
specify the attribute
parameters with the
dropdown menus. In this
example, the parameters of
Likelihood and Severity are
characterized as probably
and catastrophic,
respectively. Click OK.

The risk attribute should now
appear in the node’s Edit
Attributes with the specified
parameters. Click OK.

The risk attribute now
appears in the node’s
metadata field in the
Properties panel.



Adding Attributes Directly to the Library
File Edit

Attributes do not have to be created About AdvoCATE
Only when edltlng a node’s metadata. Preferences... 38,
ervices >
Add an attribute to the library by: T
1. Selecting Preferences from the b
AdvoCATE tool menu. SURATNEAIE %9
2. From the Preferences box, follow ano |
the steps as for adding an =
attribute to a node. | Do S
a. Name the attribute and select its
parameters. In the Add Attribute <o O s
box, click OK.
b. The new attribute should appear bt B

in the Attributes list of the
Preferences box. Click OK to
close.

| Restore Defaults | | Apply |

@ [ Cancel | (ncwnml




Parameter Type ID: SameNodeTypeld

8mnA Attribute Selection

Attributes are defined on the Attributes preference page.

Select an attribute: z

| (@ formal

| 8 formallzes{SameNodeTy peld)

| (@ formalizedBy(SameNogfe Typeld)
| (@) hazard{Hazardld)

| (@ requirement{Tier)

| (@) riskiLikelihood, Severity)

| (@) specifiedIn(String)

| (8) usesAssumption{AssumptionNodeld)

| (8 usesRequirement{GoalNodeld)
(@) verifiedBy(ToolName)

kai] Cancel | | oK

|

Edit Attribute

formalizes(SameMNodeTypeld)

SameNodeTypel Gl er!
G2: Goal 2

@

Cancel

Each parameter contains an ID that
indicates something about which
nodes it can be assigned to. Add the
SameNodeTypeld attribute to a node
to represent relationships between
nodes of the same type.

For example, select a goal node, and edit its
attributes. Click Add. In the Attribute box,
select and add an attribute with
(SameNodeTypelD) as its ID. Click OK.

In the Edit Attribute box, notice that this
particular attribute ID is specific to goal
nodes only—because that is the node type
this attribute is assigned to.
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Parameter Type ID: SameNodeTypeld (cont.)

_F2rE =it Alipihite Continuing this example, select a
formalizes(SameNodeTypeld) node from the list (in this case,
SameNodeTypeld | G2: Goal 2 oy gOaIS) and click OK.

@ [ Gancet. -] e The attribute should appear in the Edit

- Attributes box. Notice that the attribute
Na¥a Edit Attributes (Goal G1) ID is the node specified during the
Attributes: previous step (G2). Click OK,
(@) formalizes(G2) Bl caddi.
/ o The attribute now appears in the
" metadata field of the G1 node’s
v properties.
@I | cancel | [T]
Praoblems <= Tasks E Properties £2 9= Parameters = Console Search g Ess

* Properties

Identifier: Gl
Description: Goal
Metadata:

Comment:

Hyperlinks:



Attribute Type: Synonyms

/!0 Praferences
Synonyms =] b
F General v
W Acvoic bl Add, edit or remove synonyms.
 Build © Hazardld Add.. |
¥ Editor £ Requirement B
¥ Attributes ) system T
Enumerations = :
=) ToolName
—
Stylés o Remove |
B Formal Tools
¥ Data Management
FRun/Debug
BTeam
| Restore Defaults | Apply
IL’?“..J Cancel | [ oK |
ann Add Synonym
Synonym; | FormaJLangu:Lge|
Type: |-Sring
( ‘?j | cancel | oK |

Most of the Attributes covered so far
have contained editable
enumerations (e.g. likelihood,
severity, etc.) but another attribute
type is the Synonym.

To add/remove/edit synonyms:

1. Navigate to the Attributes preferences
box

2. Under Attributes, select Synonyms

3. Click on an existing Synonym to edit or
remove it OR click Add to create a new
one. Enter the name of the new
Synonym and click OK. It will
appearance in the list of Synonyms in
the Preferences box.

For example, to add a Synonym called
formalLanguage, click Add in the
Preferences box, type in formalLanguage
and specify the Synonym type (here, it is
“string”) and click OK.



Editing Properties: Adding Hyperlinks to Nodes

Adding a hyperlink to a shestissat] T

System A is 4D‘-/ Definition of [E Seiett
d . t h t acceptably safe -.\ 'EO: f;_abhf /.-J L_,; Marguee
no e IS ano er Way O 7 3 .E'I,I-C- nnnnn 1.:ions 4

edit its properties. il 2= poe

el -

Al Y " HiLink
Rag Iat s have been hasad A |
] E “{Tf‘zard < Undo Delete | = Objects 5%
1 / Bt | Elcoal

The methOd Of addlng -' WA:E‘EC’;W:‘“ 'f & Print... & Assumption

. . ,./’ ’ 2488 Copy 0 Context
hyperlinks directly to a \gx o o i

. . . L i gm:qalj?ngs s%prn“;\g ) . D Justification
node is similar to y TRl Ry Ui sy

System A meets the El HiGoal
ralevant regulations Layout

adding attributes. BCTS  Cgocbies | S

. . Fo.fﬂahze Ei _y.perllnks
1. Right-click to select \‘/—\ o 1 —
the node. From the it srowitide. >
= i A iy Hierarchy Y — - o
menu, select Edit e i s i "
B Sy = —  Export Diagram... ®O -

and then Edit
Hyperllnks Edit Hyperlinks (Assumption A1)
2. In the nOde,S Ed|t Hyperlinks:

Hyperlinks box, l _
add a hyperlink by
clicking Add.

l:?] [  cancel | | oK




Editing Properties: Adding Hyperlinks to Nodgs

3. Add a hyperlink from multiple —_—
sources. Hyperlink:
a. Click Browse Projects to
link to an existing project
resource or folder. In the

= Browse Project... | | .;5 Browse Workspace... | | E Browse File System... |

search box, specify the @ [ Cancel | [ oK
search terms in either the ano
Resources field or by Seect a resource 1 open ( = any charate, * = any strng)
icki 1
cé:I:cILlngKa mong the folags. In this example, the user clicked
;| .project .
|C . |55 argument-demo.argument < Browse PrOJeCt In the Search bOX,

b. Click Browse Workspace\o
link to an existing
workspace resource or
folder. In the search box,
specify the search terms in

the user typed * to show any string of
resources and folders associated
with that project. The user selected a
resource and clicked OK to close the
i folder search box. The resource hyperlink

sfiherthe Resources Teld  ~ ammm— appeared in the Hyperlink link field of
?orld()a/rg ICCIIiZE gn}gong © the Add Hyperlink Box.
c. Click Browse File Systemto @ —Goncel | [0
link to local files. Select a s aidiasing
file and click OK. = —————e — = e
d. Type |n a Web URL dlreCﬂy Hyperlink: Iﬁlg:..‘._iS{W:_:.rkspi_lce_lﬂcrfargumi_z_-nl—demn!fargument—demq.argument_]-
IntO the hyperllnk fleld |_@£{}WSE Project... | I'E Browse Workspace... -I BE Browse File System... |

Click OK to close the Add Hyperlink
bOX I;’"E'H'! Cancel | | OK |




Editing Properties: Adding Hyperlinks to Nodes

@ O O Advocate — platform:/resource /argument-demo/argument-demo.argument#/0 — AdvoCATE - (Users fvjphilli/Desktop/advacate 2 fadvocate.app... '

4. CIiCk OK to Ciw ] IleJ =i " v <oy - | &+ | =} | | | ||= | (=1 Li{l 100% | | { Q, Quick Access ) ¢ rifi T Advocate
close the Edit B *arimeiiodetin s =58
Hyperlinks box. |Graete

. S W T Select
The hyperlink s, ——D( =R ) o

ShOUId nOW L/_—'b Cannect.ians {\ol

— IsSolvedBy

appear in two BREELIEE = ~* InContextOf
= A1 . ||@ — HiLink

p|3095_1 In th_e e ) T
Hyperlinks field / Agumentat :

A M Goal
/' compliance with W Assumption
¥y regulations

in the node’s

7 Context

. ey O Evidence
Properties panel Palon e @ stiication
\\_‘ regulations 5 {7 Strategy
G2 “--._______ ____._.-F-" J
and as a globe ey s — {5 Hicoal

icon when
hovering over
the node.
Clicking the
globe icon will
open up a
dialogue box to
select a link to
naVigate tO. Hyperfinks: | file://S{workspace_loc: fargument-demo/argument-demo.argument}
Some hyperlink R —

files will open as

a separate tab.

relevant regulations E HiEvidence
E HiStrategy
= T =
| == Patterns e
T |
E{

{ 3

I., )

= " - = o
Problems EE Properties &8 (x)= Parameters Search = =
election from argument-demo

= Properties

Identifier: Al

Description:  Regulations have been based on an identification of the relevant hazards

Metadata:

Comment:




Editing Properties: Editing/Viewing/Removing Hyperlinks to Nodes

8NN Edit Hyperlinks (Assumption Al)

Once a hyperlink has
been added to a node,
it can be edited,
removed, or viewed in
a separate project tab.

Hyperlinks;

‘,‘. file:/ /| S{workspace loc: fargument-demo/argument-demo.argument}

« To edit a hyperlink,
select the hyperlink
within the node’s Edit
Hyperlinks box, and click
Edit.

To delete a hyperlink,

select the hyperlink

within the node’s Edit

Hyperlinks box, and click

Remove.

« To view the hyperlink in
the separate project tab,
select the hyperlink
within the node’s Edit
Hyperlinks box and click
View.

|  Cancel | |

AdvoCATE User Guide

54



Selective Views

Selective views provide queries of hiding / showing specific views so as to manage argument structure complexity

® | Advocate - platfor It |

the right-click menu

|2 Problems ¥

Base

=P Minicture View 53 =5

Attributes:

Calor:

Tacks ' Properties 22 El Cansole

~ Properties

Identifier: S

1

Creste associated diagram Hide subnodes
Show path to this node
Show subnodes

Show all nodes/loops

Hierarchy b
View confidence data
Save as Pattern

projectlarg 0.acd#l0 - AdvoCATE e=Hfa x|
File Edit View MNavigate Search Project Run Window Help
[P R o =l 5 = e D [ oS [ o i o e o S [ L) 00 ~ QuickAccess | [ | [T Advocate )
[ Project Explorer 52 BYs = o [8 *argument-0 &% | [5) argument-0--G5 =5 )
i = ghsaa-sc o Palette I
a 1 test-project
[ argument-0 acd % e
[8 argument-0-G5.acd &1 1 i Marquee
4 1 test-project-2 SystemAis Definition of = Connections <
El ehdb-pattern.acp acc:apé:h\y acceptably sa " IsSalvedBy
8 e pattemmncys e ~ InContextOf
" HiLink
5= 7 (= Objects P
Argument of : Regulations have been based ElGoal
hazard T on an identification of the @& Assumption
mitigation d ralavant hazards -
< Undo Show all nodes/loops A '~ Context
= | print (D) Bvidence
= Print_
= D Justification
Copy ity L7 Strat
G4 G5 5\;'l e QA’E eé'y |
Hazard H1 is Hazard H2 is e
mitigated mitigated Update Ctri+F5 J (= AwayContext
. . 0 Remove Shift4Delete & AwaySolution
To invoke selective Datete S itode
. Layout Diagram (= Pattems P
VIeWS, SeIeCt a nOde, View Linked Documents ehdb-pattem
and access the Lot ; i
Transformations L
Show/Hid tioni e
OW I e Op |On In Show/Hide__ 3 Hide this node and subnodes

%

Export Diagram. .. Ctr+0

® T=g

Description: Aréumenl ;}ficurml;lﬁanc;e with regilz;liuna

m

Comment:

IElme

Urls:
Variables:

|21 To Be Instantiated
[ZITo Be Developed
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Selective Views

On selecting a view, a node or its parent, as appropriate, is decorated to indicate that the view includes hidden structures

' Advocate - platfor celtestpro] 0 0.acd#l0 - AdvoCATE
File Edit View MNavigate Search Project Run Window Help
8- B R S [ 37 - = S S 2 o | i R | 2 O = oo - Quick Acces i | [ Adweate]
[ Project Explorer 52 2% Y= 8 [8 *argument-0 &2 | [S) argurnent-0--G5 = TO ShOW a hldden
b = gbsaa-sc i Palette 1> .
4 = test-project s Select Stru Ctu re .
[8 argument-0 acd o
S rgument0-G5 acd G o e 14 select the decorated
4 = test-project-2 SystemAis > Definition of (= Connections <
[F] ehdb-pattern.acp accepgh\y "acceptably safe”  IsSolvedBy node
[ ha-pattern.acp -.3 ~ InContextOf ’
" HiLink 2. acceSS the
= (= Objects @

S show/hide option
2 pesumpion from the right-click

O Context

OEwdence men u

D Justification

= O Suategy 3. select the

Argument of
hazard
mitigation

Node decoration
to indicate that
there is an

attached hidden s — El AvayGoa e v
mitigated mitigated E AwayContext a rO rla e VIeW
structure. > - 8 AwaySliion pprop
EHiNode
(= Pattems @
ehdb-pattern
ha-pattern
Problems % Tasks B Properties 52 | El Console ® T =0
=

Base

~ Properties

£F Minioture View 53 = o Node - @ E]

4 Goal G1 =
< Strategy S1 H
4 Assumption A1 1
4 Justification J1

4 Context C1

4 Goal G2

o e

4 Is Solved By Is Solved By =
% In Context Of In Context Of H
4 In Context Of In Context Of 1
4 In Context Of In Context Of

4 Is Solved By Is Solved By

A ln Oalind Dut le ©abind D -

(]




Search

To search for
keywords appearing in
the project’s text,
open the Search
dialogue box by
selecting the Search
tab in the application
toolbar (or using the
keyboard shortcut).
Within the Search
dialogue box, choose
to search within the
AdvoCATE application
or within local files by
1. Clicking the
Customize button
at the bottom left
of the dialogue
box and choosing
an Advocate
Search or local
File Search OR
2. Selecting either
tab at the top of
the box.

() | Cusome... __ Canexl _
v
Properties £ .| a
= Properiled
erniner rgument-gma
Description
Bode Ll
< Coal 1
% Serategy 51
Content ¢
v sers/vjoh ROUICE /A GUMANL-GEMO/ argument -demo. argy . dvoCATE « /Usees viphilli/De oD, o
| | i voox |- | o [ £ stoce ol w4l al \ DR 100% 1= G uick Access N 2 [ dacon
= ano Search Page Selection
= i
=n & *argument-demo 53 =8
Select fram the pages shown in the dizlog:
o Palente 3 s Palette b
Search 3 select s Select
1 Margquee Marquee
[ Aivocus sewcn RETTEVTEY
Connections
& T isSoivedy
+ ) [ Case sensitive = mmadin
~* Hitink
Field- = Objects.
g Identfier Elgoal
Oescrption A Assumption
¥ Metadata i
Fcommet 0 B | DCesten
Links o 4
........
7 swategy
[ Miceal
— i Mitvidence
< [EHistategy
Choose.
= Patterns.
) s Cancel Sea
—_—
arameters 4" Saarch ™ ven =ms T Properties 5% =0
Froperties
L Identifi argument-demo.
Descri| | ——
+ | Node *i|%
+Goal G1
+ Stategy S1
Context C!
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Search in AdvoCATE

Limit the scope of the
AdvoCATE search by: Enter Search terms here
e Limiting the search to

specific node types by

checking the appropriate 800 Search - Narrow the Search to specific
boxes under Node in the % Advocate Search  IERITS™. (0 node types by checking the
search dialogue box ”C""ta*"'mg i - 7 boxes besides each Node

e Limiting the search to T =l

specific fields within the Node: Field:
node arameters b gﬁ\ssumption / g Identifier
¥ Contex Descripti .
P Y _ o s ‘@ sy G Narrow the Search to specific
checking the appropriate R o B e node parameters by checking
boxes un_der Field in the @l 0 = 0 the boxes besides each Field
search dialogue box.
. . Scoy
e Defining the scope of the D:m e
. . (=) Workspace Selected resources Enclosing projects
search to be within the CoWorkingser: | €= s Define the Scope of the search
* The Workspace —
* Selected Resources _— —
* EnC|OSIng PrOJeCtS L:?) | C;stm_"nize..._l I- Ca-nc-el_

* Defined Working Sets

One the search terms have
been entered, click Search.
Search results will appear in the
Search panel below the canvas.



Search in Files

Limit the scope of the File
search by:

Limiting the search to
specific File name patterns.
Separate terms with
commas.
Limiting the search to
specific file extensions by
clicking Choose and
selecting the appropriate
file extension type.
Defining the scope of the
search to be within the

* The Workspace

e Selected Resources

* Enclosing Projects

* Defined Working Sets

&)

.6 Search

One the search terms have
been entered, click Search.

Search results will appear in the
Search panel below the canvas.

Enter Search terms here

| ?‘Admcme Search E@'é;[_’}_;; reh

Containing text:

r —— e

* = any string, 7 = any character, | = escape for literals: * 7 \}) || Regular expression Enter terms here to Sed rCh

| Whole word hrough File name patterns
File name patterns (separated by comma):

[* Mg *| | choose.. |

v | |_| Case sensitive

(* = any string, 7 = any character, Ix = excluding »)

\ Choose which file extensions to
search through

["| Consider derived resources

Scope
(=) Workspace | Selected resources Enclosing projects
l_: | Working set:
Define the Scope of the search
l::?:l | customize... | |_RE|EI|aCE.._ || Cancel | [ “Search ]




Structuring Arguments
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Associated Diagrams

« Associated diagrams manage argument
structure complexity by splitting a
structure across multiple canvases.

* An association connects source nodes
to target nodes through an association
property within the nodes’ Properties.

— The target node will show a Continued-
from association.

— The source node will show a
Developed-elsewhere association.



Example: Associated Diagrams between Existing and New
Arguments

Module2 *Module3d "contract] [t *argumentl 53

[ —— —

To create an association -
between an existing _J
source node and new
target node,

1. Select the source node
and, in its Properties,

i Problems = Tasks = Properties 82 [l Console (9= Parameters

~ Properties

click the Association s
drop-down menu and ey
select “Developed- & o

To Be Instantiated

elsewhere”. A green box
will appear in the lower
left of the node.

To Be Developed
Public

To Be Supported By Contract

Associate d Arg t:
2. An Associated Argument m—
Selection box will

appear with a field to

search through existing

arguments with that

node name and type.If 7
none exist, click <New> e
and then OK,



Example (cont.): Associated Diagrams between Existing and New
Arguments

3. Select the projectin

which to create the (S Modulel [ Module2 [ Moduled [ “contactl [ “argumentl | [ “argumentz 3
target node and name

the target argument. 2‘*‘7
Click Finish. T

 The new node should
now show a green box
on the upper right,
iIndicating that it is

associated with another
node. The node’s

mmmmmm

Properties indicate that
it is “Continued-from”
another node.




Example (cont.): Associated Diagrams between Existing and New
Arguments

Clicking the icon on
the upper right of

Goal

either node will direct —
to to its associated
counterpoint.

[

Open Associated Argument
Open argument(s) associated with this goal




Example: Associated Diagrams between Two Existing Arguments

*Modulel Module2 Module3 contract] [15 *argumentl 53

To create an association between an
existing source node and an existing
target node,

1. Create two nodes of the same name,
one in each of two arguments. For
example, G1 in argument1.argument

i3 Problems &= Tasks = Properties £2 [l Console 9= Parameters

~ Properties

and G1 in argument2.argument.
2. Select the source node and, in its

Properties, click the Association drop-

| To Be Instantiated

down menu and select “Developed- 170 Do
elseWhere”_ A green bOX Wi” appear in - To.Be.SuppchEdBYCOTIlﬁ!CT
the lower left of the node. i - A
3. An Associated Argument Selection box .

will appear with a field to search through

|5 <New>

existing arguments with that node name

and type. Select the appropriate /
argument (in this example,

argument2.argument and click OK.



Example: Associated Diagrams between Two Existing Arguments
(cont.)

4.

AdvoCATE will
automatically open the
target argument’s
canvas. In the
Association drop-down
menu of the target
node’s Properties,
select “Continued-from”.
The node should now
show a green box on
the upper right,
indicating that it is
associated with another
node.

Clicking the icon on the
upper right of either node
will direct to to its
associated counterpoint.

Open Associated Argument
Cpen argument(s) associated with this goal




Hierarchy

Another method to reduce a diagram’s complexity is to employ Hierarchy to
create a recursive group of meaningful subsets of the argument structure.

To add hierarchy:

1. Select the root node. Optionally, select additional nodes to include in the
hierarchy structure. Right-click on the root node.

2. Select Hierarchy—> Create Hierarchical Node

[ *Modulel [z} *Module2 [z *Module3 [5] *contractl [ *argumentl [=] *argument2 [ *Moduled 53 =

~2 Palette [»

<] L

Hierarchy -;. sl
e A 71 Marquee

4|>
Cu rrently | b El;fvf'onnections £
Al \ E ? .. ] IsSolvedBy

" InContextOf

Can nOt be T—— A j’r f & Undo connection creation —* HiLink

. Print... | Objects &
applied to —‘T 31@3 j ‘:DW =
Al Agsumption
Paste o

p atte rn S O r ! Context

Update 10 Fc OEvidence
‘ Delete ) Justification
m Od u IeS . Lo Laygut L7 strategy
/ E1 Edit... > QAwa\,-Ccai
|: Add Node > [ AwayContext
h Change Node Type »
S~ Show/Hide... > R
Hierarchy [ ] Create Hlerarch!ca[ Node
Save as Pattern Open/Close Hierarchy
, Calculate Hierarchy
| Export Diagram... #0

= _ = i - 3 =% O =



Creating Hierarchy

The structure undergoes
auto-layout whenever a
hierarchical node (hinode) is
created.

AdvoCATE currently
computes three kinds of
hinodes, subject to certain
conditions:

* hierarchical goals
(higoals), annotated as G

* hierarchical strategies
annotated as S

 hierarchical evidence
annotated as E

The hinode type is
determined by the nodes
contained within the
hierarchical structure.

*Modulel *Module2 *Module3 *contract 1 *argumentl *argument2 *Module4 53

/E N

\ /
\H_ _//

Hierarchy
node (hinode)



Example: Creating Hierarchical Structures Ji

The next several slides will walk through
creating hierarchical goals, strategies, and
evidence structures based on the complex
diagram at right.

Note that the rectangles are goal nodes, the T T
oblong shapes are context nodes, the ovals ) y I

are justification nodes, the circles are

evidence nodes, and the parallelograms are

strategy nodes. VoA

At each step you select the root of the | \
fragment which will be turned
into a hinode and, optionally, the nodes that J, L

come just after thefragment to be included
in the hierarchy (the delimiting nodes).

Multiple nodes can be selected using ;
Command-click.




Example: Creating Hierarchical Goals

To create a
hierarchical goal,

1. Select G1 as the
root node.

2. Select S3 and
S2 as the
delimiting nodes
for the hierarchy.

3. Right-click on the
root node. Select
Hierarchy—>
Create

Hierarchical
Node

&

= Print...
Copy
LEEEE Paste

Alignment
Update

Remaove
/ Delete
: Layout
= Edit...
Formalize
Verify By...
Add Node
Change Node Type
Show/Hide...
Hierarchy
| Save as Pattern
Queries

Export Diagram...

Delimiting nodes

Root node:

/ Goal

<2/ Undo Delete HiNode

Create Hierarchical Node
Open/Close Hierarchy
Calculate Hierarchy



Example: Creating Hierarchical Goals

The selected
area is
condensed into
a hierarchy,
leaving the rest
of the original
diagram intact.

Hierarchical
Goal




Example 1: Creating Hierarchical Strategies

To create a
hierarchical
strategy structure,

1. Select S2 as
the root node.

2. Select G4 and
G6 as the
delimiting
nodes for the
hierarchy.

3. Right-click on
the root node.
Select
Hierarchy->
Create
Hierarchical
Node

O--0-=0
] i
O=C=0

Root node:
Strategy
o < Undo Delete HiNode
/ & Print...
v Copy

Paste
Alignment >
Update 3R FS
Remove i
Delete
Layout
Edit... >
Formalize
Verify By... 3

' Add Node >
Change Node Type ]
Show/Hide... S
Hierarchy > Create Hierarchical Node
Save as Pattern Open/Close Hierarchy

- Queries 3 Calculate Hierarchy

Delimiting
nodes

Pl
. L
|

Export Diagram... #®0




Example 1: Creating Hierarchical Strategies / \

A

The selected

area is l :

condensed into |

a hierarchy, . . l J.
Hierarchical ;

leaving the rest Strategy i

of the original / :
diagram intact. |




Example 2: Creating Hierarchical Strategies Structures

To create another
hierarchical
strategy structure,

1. Select S5 as
the root node.

2. Select G8 as
the delimiting
node for the
hierarchy.

3. Right-click on
the root node.
Select
Hierarchy->
Create
Hierarchical
Node

|

\ - Root node:
L v Strategy

<2 Undo Delete HiNode
= Print...

Copy
Paste

Alignment >
Update FEFS
Remove @
Delete

Layout

Edit... >
Formalize

Verify By...

Add Node

Change Node Type
Show/Hide...

Save as Pattern Open/Close Hierarchy
Queries " Calculate Hierarchy

>
>
| 4
|

Export Diagram... F#£0

Delimiting

nodes
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Example 2: Creating Hierarchical Strategles L

N

‘./"- \ ' Ea ™
( ) ( )

The selected area \
IS condensed into .

v 1x
Gh G3 GE

a hierarchy,

leaving the rest of
the original J' l \
diagram intact. & ~AY R
4
> Lo
Hierarchical /
Strategy ¥
<=




Example: Creating Hierarchical Evidence

To create another X
hierarchical oy _
evidence structure, - /

1. Select S3 as
the root node.

2. Right-click on
the root node. . REES L eaf node-

Strategy

Root node:

Select Evidence \

Hierarchy—> | | =

Create
Hierarchical
Node

Note that because
no delimiting nodes
were selected, the
hierarchy will
include all nodes
down to the leaf
nodes.

Hierarchical
Evidence




Example: Creating Hierarchical Evidence F

The selected area
IS condensed into
a hierarchy,
leaving the rest of
the original
diagram intact.

Evidence

L
Hierarchical l l\n u
l




Example: Creating Nesting Hierarchies

L To create nested
yd uter  hierarchical structures (a
. B y hierarchy within a
hierarchy):
— ey .
1 | <7 Undo Create Hierarchical Node 1_ Wlthln a hlerarChy,
o select the a root node
for the inner hierarchy.
v Ry o 2. Right-click on the root
Layout .
- node. Select Hierarchy—>
: i " Create Hierarchical Node
Change Node Type »
Show/Hide... >
=
Save as Pattern Open/Close Hierarchy = HE
Queries > Caleulate Hierarchy
Properties Bl ci Export Diagram... *0 ra_‘_\l.t_ P:E",--ev: “\;;C;I;n .~—¥- —
V4
G
Hierarchical Goal —
nested within a Jf J
Hierarchical Evidence i'
Structure




Opening/Closing Hierarchies

Hinodes can be closed/opened to collapse/expand the argument structure.
7 Advocate - pl project O.acd#l0 -AdvoCATE B s — L | it

File Edit View Navigate Search Project Run Window Help -

'[ ﬁ%@ﬁ%ﬂf@’fm V#'T 2 - ;%f@:":g “"“"‘J{%j‘{ﬂl’| "._'"“:‘..-]\rﬁ ﬂ@'q'%%&fPEWITEF’Q ﬁ‘fi_ﬂ__% i R, vy C}ui_:_kAf;ce_s_s_ ') _‘| 7 | [ Advocate
[y Project Explorer £2 B e [§ *argument-0 52 !_ : - - —— =2t El_
[+ =% gbsaa-sc + | ¥ Palette 3

4 I test-project
8 argument-0.acd :
8 argument-0-G5.acd Traceabilty matrix

[ Select
i} Marquee

d from systemA. B
[ = test-project-2 design specificatiol = Connections <
to reguistions ~ |sSolvedBy
LR |  InContextOf
" HiLink
- L - (= Objects ]
Physical Component B i HGoal
ar;r;:m o ) mﬁ: g};ﬂ;:rdg | B Assumption
b _Z _| 2 Context
To open/close a ‘ O Evidence
. i D Justification
h n Ode . <7 Undo Move Shape ‘ L7 Strategy
. = Print.. | E AwayGoal
1. Select the hinode — M= | B AwayGontext
opy | = "
| = AwaySaluti
and launch the Past | || B
! l HiNode
H _h Update Ctil+F5 ! R
rlg ht CIICk men u Remove Shift+Delete ! - Behzt(::aitem .
2 . Se I eCt th e fas . | ha-pattern
Layout Diagram
Hlerarchy Option ~ View Linked Documents
= Add Node:
and then the Transformations 3
Search...
Open/Close Shawide '
. . Create asisocialed diagram
H IerarChy Optlon Hierarchy L  Create Hierarchical Noda T
L = d i View confidence data Open/Close Hierarchy F— =
UL.J\EmS 7= Tasks [ Properties 2% E:V‘e asmpﬁtem = [ Calculate Hierarchy = TeH H i nod eS h ave a
it -
£ Ministure View 51 =g N Buse e d fault O tat
— erau pen status
~ Properties
Identifier: H1
Description-  Argument by decomposition over architectural breakdown and operating phases
Attributes:
Comment:
Color: [G(em T
Urls:
Variables:
["1To Be Instantiated
Status: [Qpeu 24
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Opening/Closing Hierarchies

Closing a hinode collapses the node, improving visual comprehension by hiding its internal structure

| B

[0 Advocate - platform: C proj 0.acd#/0 - AdvoCATE

File Edit View Navigate Search Project Run Window Help
[T &S [ [ [ il -0 e o [ | e o | e o o | B I = | &L &) s0% -

[y Project Explorer £2 g Y=g [§ *argument-0 52
» 1= gbsaa-sc
4 | test-project &1
|5 argument-0.acd Sa‘fc't:;;::
[§ argument-0-G&_ acd safe
I 1= test-project-2 4

=] El 2
efintion of Argument of Argument o
“acceptably safe compliance with hazard
regulations mitigation

h

Traceability matric
from system A
design specificatiol
to regulations

GE

Failure hazard of component,
in operating phase 1 is
mitigated

[

[2l Problems ] Tasks [ Properties 53
|

=7 Miniature View 52 =g Base

~ Properties

Gz G4 G5
System A meets Regulations have been base Regulatory approval of safe Hazard H1 is Hazard H2
the relevant on an identification of the e e mitigated mitigated

regulations relevant hazards relgulations =

Quick Access

| = | [ Agwea)

= O

3 Palette P

[ Select
i} Marquee

(= Connections <

~IsSolvedBy
" InContextOf
" HiLink

= Objects k)

ElGoal

& agsumption
= Context

O Evidence

D Justification
£ Strategy

E AwayGoal
QAwandntext
EAwaySU\uLion
ElHiNode

= Patterns ®

ehdb-pattern

ha-pattern

® Y=g

Hinodes status is
updated to Closed

Identifier: H1

on closing the

Description:  Argument by decomposition over architectural breakdown and operating phases

hierarchy

Attributes:

Comment:

Color: [Green

Urls:

Variables:
[71To Be Instantiated

Status: [Close-d
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Example: Closing a Hierarchy

Closing a hierarchy will

minimize the hierarchical

structure, preserving the
internal nodes.

To close the hierarchy,

1. Click on the
hierarchy.

2. Select Hierarchy—>
Close Hierarchy. In
the hierarchy

Properties, the status

Deleting the hierarchy will

will indicate that the
hierarchy is Closed.

delete the hierarchical
structure but not its
contents. However,
selecting Delete HiNode
Contents will delete the
nodes contained within
the hierarchy.

imeters

. Export Diagram... ®0 |

< Undo connection creation
& Print...

Copy
Paste

Update
Delete
Layout

| Edit... >

Delete HiNode Contents
Add Node

Show/Hide...

Hierarchy
Save as Pattern

Create Hierarchical Node

(=51

2
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Calculating Hierarchies

« Calculating hierarchy screenshot



Modules

Modules prevent complicated diagrams from becoming too unwieldy by
providing connections between arguments and patterns contained on
separate canvas tabs.

The two types of modules are:
« Safety Case Module
« Safety Case Module Contract



Creating a Module

[ECH Edit  View

Navigate Search Project Window Help

Open File...

1 Advocate Project
£ Project...

To create a module canvas on a new  cesea oww | Foder
ta b [=] Save 35 é" Argument Structure
. Save As... [#7 Argument Pattern
: [z Save All {r 385 g Safety Case Module
1. Select File > New - Safety — g
Case Module .. | riOther.. N
2. Select the parent folder (usually Retresh !
a project) in which to put the S
module o e
=
3. Name the module s o s e e i
4. Click Finish s
File name: {odulel] _
_(_:})_ [ Cancel | [WEimishe

AdvoCATE User Guide

84



Creating a Module (cont.)

Notice that the new module tab contains an empty
canvas as well as some new node types in the
palette.

These node types link to goal, context, and
solution/evidence nodes in other modules or
arguments:

« Away Goal
* Away Context
* Away Solution

These node types allow link to other modules or

module contract references:
* Module Reference—Ilink to other modules

« Module Contract Reference—Ilink to other
module contract references

.= Palette
Q Select
r=1
! Marquee

=|_;'~ Connections
— IsSolved By
" InContextOf
— Hilink

E|'5"- Objects
[ Goal
& Assumption
I Context
G Evidence
" Justification

65 strategy

Q Awayloal
E| AwayContext

_|i| AwaySolution

B3 ModuleRef

Bl ModuleContrac..

i | HiGoal
EHiEvidencE
EHiEptr’m‘.-E;n-I

| (= Patterns

£



Example: Linking an existing module reference to a new (non-
existing) module

[ argumentx [# *Modulel £

 Add a ModuleRef object by
dragging and dropping or using
the shortcut

* Select the ModuleRef object /
and click on the text, which wi
display a dropdown menu with
all existing modules in that

lJ

project stey-Case odue

* To link to a new module that has S i s -
not yet been created, select eSS
<New> R

* Inthe New File dialog box, enter
the name of the new module.
(The parent folder will
automatically default to the
name of the project.) Click
Finish.

File name: |Moduled.argument

| Advanced >> |

S)

| Cancel i




Example (cont.): Linking an existing module reference to a new (non-
existing) module

argumentx *Modulel 52 *Module2 *Module3 *Moduled g The MOdUleRef ObJeCt W|” be
renamed to the name of the
target module—in this case,

Module4.
e < * To open the target module, click
e on the icon on the upper right

Open safety-case module

portion of the ModuleRef object
and select Open Module.
Clicking this link will open the
target Module canvas.



Example: Linking an existing module reference to an existing module

« Select the ModuleRef object and .
click on the text, which will display “Vodule3 [v!
a dropdown menu with all existing ]ﬁ?
modules in that project.

« Select the target module to link
that object to.

« The ModuleRef object will be
renamed to the name of the target
module—in this case, Module3.

« To open the target module, click on izl
the icon on the upper right portion
of the ModuleRef object and select
Open Module. Clicking this link will
open the target Module canvas.

[5 argumentx [£] *Modulel 82 | [=] *Module2 *Module3 *Module4




Example: Away Nodes

Away nodes simplify complicated
diagrams and link between nodes in
separate modules, arguments, or
structures.

Any target node must be marked
“public” so that it is viewable when
linked from other modules.

Add a node to the canvas—in this
case, a goal node called Goal 1—and
In its Properties, check the Public
box. Notice the folder icon that
appears in the top right of the node,
indicating that it's “publicly” viewable.

argumentx [ *Modulel £3

= Properties

{2/ Problems <= Tasks = Properties 52 |El Console @)= Parameters

Identifier; Coal 1

Description:

Metadata:

Comment:

Hyperlinks:
|_| To Be Instantiated
|| To Be Developed
™ Public
To Be Supported By Contract

Association:

Associated Argument:



Example (cont.): Away Nodes

In the source module, add an away
node—in this case, add an
AwayGoal to the canvas of
Module2. This node can be linked to
any target goal in another module.
In this example, AG1 will be linked
to Goal 1 in Module1. Notice the
folder icon that appears in the
bottom rectangle on the AG1 node.

Click the drop-down menu beside
the folder icon and select the target
module to reference (the one that
the target node is in)

Click the away node ID and select
the node to link it to from the drop-
down menu, which will only display
target nodes of the same type as
the source away node that within
the reference module.

Goal 1

Maodule




Creating Module Contracts

« Module contracts serve as a justification
for how two modules reference one
another; rather, how one module makes |
certain assumptions that are supported
by the guarantees implicit by another

module.
 To create a Module Contract,

1. Go to File>New—> Safety Case Module

i Advocate Project

Open File... = Project...
Close EW
Close All paw | [ Folder
7 File i
Save [ Argument Structure I
Save As... [F7 Argument Pattern :
| G Save All 1365 [ Safety Case Module i
Revert =* Safety Case Module Contract

Move...

£ Other... #EN

Rename...

Refresh

s Import...
CO n t ra Ct ) Safety-Case Module-Contract
2. Select the parent folder (usually a i =
project) in which to put the module. > ==

3. Name the module.
4. Click Finish.




Creating Module Contracts (cont.)

As with creating modules, notice that the new
module tab contains an empty canvas as well as
some new node types in the palette.

These objects allows linkages between nodes in
other modules, arguments, or structures:

« AwayGoal
* AwayContext
* AwaySolution

This object allow linkages between other
modules:
 ModuleRef <—

Notice that when creating a module contract
diagram, other module contracts cannot be
referenced.

=% Palerte

[:3 5elec1;

r=1
%, Margquee

= Connections
—* IsSolved By
" InContextOf
" HiLink

[= Objects
1 Goal
& pAssumption
) Context
IC]I Evidence
(0 Justification

= Strategy

LEe]

Q AwayGoal
9 AwayContext
= AwaySolution

Eh‘loduleﬂef

] HiGoal
] HiEvidence
EHiStrategy



Example: Using Module Contracts in Diagrams

Like Modules, Module
Contracts can be used to
simplify complicated
diagrams.

The Module Contract
Reference object acts as a
placeholder for Module
Contracts within other
modules.

See the example at right,
llustrating the
relationships between
several Modules and
Module Contracts with
Module or Module

Contract reference objects.

*Modulel

*Module2

*Module3 &3 *contractl

L



Example: Using Away Nodes in Module Contracts

An away node may feature
outgoing links within a
module contract

For example, to create an
Away Goal,

Drag and drop the Away
Goal object from the
palette onto the canvas (or
use the shortcut).

Drag and drop the Goal
object from the palette onto
the canvas (or use the
shortcut). Add a link
between the nodes.

Within the Goal node’s
Properties, check the box
“To Be Supported by
Contract”. Notice that a
module contract reference
icon appears below the
Goal node.

x]

AGA

G1

argumentx

*Modulel *Module2 *Module3 *contract 1353




Putting it All Together: Complex Diagram Walkthrough

Here is an example of a more complex diagram by a hypothetical user that integrates
the concepts introduced during previous slides.

The following slides will & & main-module 52
show, step by step, how

to create the diagram

shown here and link it

to other modules in

G

various ways. (i sy
This user’s module N asitssen are mitgated
diagram consists of: |
* AGoal G1 fetiy A oy
* A Context C2, y R ,s/_l:)':., ':h?:mnf; J.'
marked public ' pres ) N (Gonope) /
* A Strategy S1 /
* A Context Cl, i
marked public R Pl Yo
e An Away Goal G2, ey B
linked to another B  crow mf.%:nd
module CPHM Hazards Module

e Anda module
reference DLPHM



Putting it All Together: Complex Diagram Walkthrough (cont.)

To create the main-module

diagram, the start by employing

the keyboard shortcuts to add

nodes G1, S1, C1 and C2 and then B [5 main-module | [2 *CPHM 5%
fill in their descriptions.

To link this main-module

argument to another module

called CPHM, which has already e I
been created, link the diagrams °”§i§1!f*§l$yif§§;if;“

mitigate
through a goal node with the

description “Hazards in the
‘cruise’ operating phase of the
aircraft are mitigated”. This is G2
in CPHM.



Putting it All Together:

To link the modules, the user:

1. Navigates to the Goal G2
in CPHM and marks it
public in the node’s
Properties.

2. Next, the user adds an
Away Goal to the diagram
and fills in its description.
Notice at this point that
the identifier of the away
goal is AG1.

3. Next, the user specifies
which module the Away
Goal AG1 will link to. The
menu lists all existing
public modules in this
project. The user selects,
in this case, CPHM.

Complex Diagram Walkthrough (cont.)

[x3] [ *main-madule [ CPHM 83  [=] DLPHM [=] fes 5] C-FITH
Lt T A [
2 A‘I{mptﬂfopﬂmfﬂl‘lé
H'EZ‘E“:!S i e Sonliee for the aicaft systﬂml
| operating phase of the | {ConOps)
1 gircraft systam are
mitigated
g - main-module
Probler Tasks E Properties 22 Consocle - Parameters Search
~ Properties

ldentifier: G2

Description: Hazards in the “cruise” operating phase of the aircraft systerm are mitigated

Metadata:

Comment:

Hyperlinks:
| To Be Instantiated
| To Be Developed

™ public

| To Be Supported By Cont

AGA I‘/
Hezards in the cruise
operating phase of the
gircraft system are

rnitigated.

-

B CPHM v
fcs b
DLPHM

Cotv_

<Mews




Putting it All Together: Complex Diagram Walkthrough (cont.)

4. Next, the user must
change the away goal
node’s identifier to link G1
in module CPHM by
clicking the identifier and
choosing the appropriate
goal from the menu of
public goals in CPHM.

Notice that the away goal’s
identifier is now G2, matching
that of the goal that it is
linking in CPHM. The icon at
the top right of the node will
link the two modules directly.

.

et

AGT K
Hazards in the cruise |E1 #GE 5 [
operating phase of the -
aircraft system ame |
mitigated. Cd
[
—_— <New>
= CPHM
T T Fe CPHM
G2

Hazards in the "cruise”
operating phase of the
aircraft system ame
mitigated

CFHM




Putting it All Together: Complex Diagram Walkthrough (cont.)

The main-module diagram now features an away goal linking it to CPHM. Next the user
wants to add in a reference to another module DLPHM, which has not been created yet.

[x4] [ main-module 22
N N G1
= [+
/ Hazard -H\, All identified hazards
[ analysis of the :ﬂ—fclrtha aircraft system
A aircraft systam o are mitigated
| - [l]
1 & 75 C D
4 5y All entified hazards
( ,,na,,“,';?ﬂ e ‘,q_ for the aircraft systam
I‘\ aircraft system /’ aaaaaaaaa
e =Y
7 P -
4 7 Concept o \1

/  operating

/ \ system i / Argument / operations for
/ phases / ConO / /  ever f;bl the aircraft
£ {CanOps) A / operating / \ e
= Pkt \
i -

i
G2 *

Hazards in the "cruise”
aparmating phase of the
aircraft system are
mitigated

B= CPHM

fArgul'nEI'li f aparations for L i P_-
~ 5] =
; rar ’_Dl the sircaft | / : "/ e \‘
/




Putting it All Together: Complex Diagram Walkthrough (cont.)

The user:
8D New File
1. Adds a Module Reference TR
Node and inCIUdeS the name Of (g it a Create a safety-case module file resource. =3
. Landing Phase ——
the module to be referenced in ] Hazards Module Sk S SR S AR

= examples

the node’s description. In this
case, the user wants to S eamples
reference the Descent and

Landing Phase Hazards Module

(DLPHM). — +
2. Clicking the node’s identifier ;':E“r" 'I
will list the menu of all CPHM
available modules to reference. ; FE st DL bLargament .
Since DLPHM does not exist, it |_Advanced >> |

isn’t on the list, so the user
selects <New> and names a
new module DLPHM. This

fu?zl | Cancel | [WSrimishia]

automatically opens a new tab
for that module. =

*main-module CPHM DLPHM 53



Putting it All Together: Complex Diagram Walkthrough (cont.)

The user now can create the desired e = : Y.
DLPHM diagram. The user wants to add a
goal that is under development and a &

context that links back to the main- S
module diagram. To do so, the user: >
1- Adds a Goal Gl and ﬁ”S in its Problems Tasks 'E Properties 82 El Console - Parameters

~ Properties

description. In the G1 node’s N i =

. Description: All identified hazards for the descent and landing phases for the aircraft system are mitigated
Properties, the user checks the box fotee

Comment:

“To be developed” and a green
diamond appears below the node on W inipiigss

Public

the diagram.

2. Adds an Away Context AC1. In the
dropdown at the bottom of the node,
the user selects the module to which
this node will reference. In this case,
it’s the main-module diagram.

3. Clicks AC1 and specifies which context | .
node in the main-module diagram to o Wamiiiary

v !

All identified hazards for the = I'ItﬁElFlt of Dfliltﬂrﬂt::rnﬁ,
1 1 g descent and landing phases rthe aircran system
||nk tO. In thIS case |t S Cl The away far the aircaft system ane (ConOps) 'l
mitigated |

context node’s identifier and T
description automatically populate <o ' :
with the C1 node’s information.

C1l ¥

C2 i
<=




Putting it All Together: Complex Diagram Walkthrough (cont.)

The main-module diagram now resembles the example. Next, the user wants to add some
elements to the CPHM module diagram.

[t 5] main-module &2 |1 CPHM |z DLPHM
- G1
- C.:!
i = All identified hazards
! Hazard ;
|: analysis of the (]_fnriha aircraft system
\ f itigated
% aircraft system // Srecn
S, e
,.-"' ; l ,.-"l Cun{:a pt u!
/ Argument -' operations for
y ‘:"'"5'1’_ /_[>| the aircraft
operating i R
/ \ sys
phases 'f 1‘\\ [ConOps) _,r"ll
G2
Hazards in the "cruisa®
oparating phase of tha
gircraft systerm are
mitigated Descent and
Landing Phase
Hazards Module
= CRHM




Putting it All Together: Complex Diagram Walkthrough (cont.)

The user wants to create a diagram
branching off of G2 that includes:
* An Away Context linking back to T T [ CPm
the main-module diagram from G2
e A Strategy S1 linking from G2
* An Away Context linking back to oy
the main-module diagram from S1 ey e ol
« A Goal 3 linking from S1 iy
e A Goal 4 linking from S1
* A C-FITH contract reference to
another existing module called C-

FITH, which in turn references G4




Putting it All Together: Complex Diagram Walkthrough (cont.)

These nodes simple additions using
the keyboard shortcuts.

main-module [ CPHM &2 C-FITH

1 1 e g = S e B
To link the away contexts to the main Cazards o the B0 ncept of operationd
operating phase of the fﬂrlhﬁ[&rﬁg?ﬁsjﬁmm
module, the user i P
1. Selects the main-module from the B main-mosue

away context’s reference menu.

2. Specifies the desired context node Y E ——
1 H Argument over [ Hazard analysie of |
in the main-module to reference. P st e P | st e

,-"j hazards for the

F, cruise phase

£ 'd - main-madule

To add the contract reference node,

the user: s —
i Fipksroil sl
1. Clicks the module contract’s "
identifier and selects from the i
menu all of the modules —
Contract for the flight
into terrain hazards
module
¢ —

C-FITH ¥

< e




Putting it All Together: Complex Diagram Walkthrough (cont.)

The user wants to link G4 to the C-FITH
module diagram via an Away Goal node. To
do so, G4 must be marked public in CPHM.
To create this link, the user:

1. Adds an Away Goal node to the
desired location in the diagram.

2. Selects from the reference menu the
module to link to. In this case, it’s
CPHM.

3. Clicks the away goal node’s identifier
and selects the Goal G4 node within
CPHM. The identifier and description
are automatically updated to match
CPHM'’s G4 information.

=

"' Yek

G4

: 1 c2
CPHM A

main-module

s 5 <MNews

DLPHM

<M Ews

I3 ?1 7

'

=

&5 main-module 5] cPHM [& *C-FITH 2

T
Hazard analysis of |

the aircraft system

h main-module

AG1
‘Controlled flight into
termain hazard is

Uncontrolled flight
into termain hazard is

7 g =

G4
Collision with terrain
hazard is mitigated

Bem crom

=




Putting it All Together: Complex Diagram Walkthrough (cont.)

Other notes about the C-FITH module:

* Notice that the AG1 and AG2 and are
not associated with any defined
modules, as they are marked “To be
developed.”

main-maodule CPHM C-FITH 2

G4
Callision with terrain
hazard is mitigated

");E_ rd '_}‘ Argument / iy C1 e
 Hazard analysis of | / / r \\

the aircraft system ! LT . il D f Hazard analysis )
<| / S0ENan0s o / of flight into
/ fightinta | LN 3 S

/ SO ! o temain hazards -
! termain Fi —— -
/ / \
c=ZE - __-_""x.

AGH / J1 \\
Controllied fiight into ( g::'st:kr;wpr::::l::: )
terrain hazard is i 2 3 d
mitigated \\x_ variety of scenarios //
AGZ — 1

Uncontrolled flight
into terrain hazard is




Putting it All Together: Complex Diagram Walkthrough (cont.)

The user has created a complex diagram spanning several modules by using various links and
reference tools. How a diagram is broken up is determined by the user. Some diagram
elements, like the DLPHM reference node and G2 away goal in the main-module diagram,
perform similar functions (linking to other modules) but can be realized in different ways.

e G1
c2
F s =] =% All identified hazards e
% ) for the aircraft system G2 $
l\ st ol e are mitigated 4 5 h iécll'l{ﬂpt of opemtion
\, aircraft systemn /’ Hazaerds in the "cruise i .
£ - ; rthe aircaft system
_— operating phase of the {CanCips)
aircraft system are "
mitigated
‘/"- 1 .-““"». T
i i Fi Concept o \ h main-madule
l.,-" Argument  f f operations for A
i/ i) /_D( the aircraft |
/ operating _.-"l =ystam /
phasas \\ {CanOps) y

G2
Hazards in the "cruize”
opemting phase of the
aircraft system ane
mitigatad

B= CPHM

Main-module

Dascant and
Landing Phase

Hazards Module

G
All identified hazards for the
descent and landing phazes
for the aircraft system ang
mitigated

o

EEEEETES"

G3
Mid-air coliision
hazard is mitigated

S L P

ncapt of operations,

far the aircraft system
[ConOps)

|- main-module

DLPHM

,-"'r &1
Argumeant over
Fi all identified

4 hezards for the

cruise phase ).f

Collision

f—

/ D the aircraft system
'l
'

hazard is mitigated

. £ (e
J.-"" |""Hazard analysis O;\'I

- main-madule

G4
with tﬁ%

TCFITH

Contract for the fight

into temrain hazards
module

—_—

CPHM

G4
Collision with terrain
hazard is mitigated

W i 8
[Hazard analysis of |

{ ument
the aircraft system SHEE
/ in
Bem main-module / emal

AG1

Controlled fight inta
terrain hazard is
mitigated

NE]

Collisian with temain
can take place in a
variety of scenarias

C-FITH

N

/



FM Integration



Queries
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Transformations
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Transformations

AdvoCATE currently offers the following transformations:

/\

Computing metrics: Generates a pre-determined set of metrics on the chosen argument structure
Creating a narrative: Generates a textual representation of the argument structure in a pre-defined format

CSV export: generates a comma-separated-value file in a predefined format for import into a spreadsheet to view a
tabular representation of an argument structure.

Extracting Assumptions / Evidence / Hyperlinks: Extracts all the assumptions/evidence nodes and the specified
hyperlinks in all nodes.

Traceability transformations: Lists the traceability links between Goals (with metadata marking them as Hazards, or
Requirements), Strategies and Evidence. Three types of such links are generated

a. Hazards to Requirements
b. Requirements to Strategies
c. Requirements to Evidence

Task list: Generates a list of incomplete tasks in the argument structure, i.e., nodes marked as undeveloped

Transformations can only be applied to argument structures.
They cannot be applied to argument patterns



Launching Transformations

Some transformations can be launched by selecting the Transformations option on the right-click menu, anywhere on the canvas

= Miniature View £3

Transformations

Search...

Show/Hide...

Create assaciated diagram
Hierarchy

View confidence data
Save as Pattem

Export Diagram...

Ctrl+0

~ Properties

Node :

F2 Tasks | [ Properties 53 E

Create Narrative

Extract Assumption
Extract Evidence
Extract Hyperlink

Hazards To Requirements
Requirements To Evidence
Requirements To Strategies

Compute Metrics

[ Advocate - platform: Itest-pral O.acd#/0 - AdvoCATE =mfof x|
File Edit View MNavigate Search Project Run Window Help
[ 5 i A 2 e bt IR S e - QuickAccess || % | [ Adiocats)
[ Project Explorer £ BEE =0 |[§esgumentn = m
- 13 El]:lsaavsc sysm 2 o1 ) * | 5F Palette 3
£] hdb.acp tem Al Definition of —
=cosplably X " =- Select
[8] top.acd Bl ‘acoeptably safe %1 elec
4 1= test-project Reguiatory approval of safery & L.+ Marquee
[S] argument-0.acd . ,wum = (= Connections @
[5] argument-0-G5.acd PO ~* sSalvedBy
8] argument-0-hierarchy acd hazard e
i B oSt aech2 mitigation . InContextOf
[ ehdb-pattern.acp zns nay HiLink
[F] ha-pattern acp mzm{md:lm - (= Objects %
] o5 M Goal
Hazard H2is Hazard H1 s -
Bystem A is oonpliant with the . mitigated mitigated & Assumption
- = Context
(O) Evidence
peets =,
<& Undo Move Shape =t B & Justification
hs
= Print_ Argument by [T Strategy
Copy QAwayGual
Paste L Q AwayContext
7 & AwaySolution
Update Ctri+F5  fhamrix EHin \;
iNode
Remove Shift+Delete mmi,,, L
Delete = (= Pattems @
Tz
Layout Diagram Physicsl Schpaiamy
— architecture of binaltiin
View Linked Documents Siorans migated mitgaled P
Add Node ry

o=

[BE =

<+ Goal G1

< Strategy 51

< Assumption A1
4 Justification J1
% Context C1

4 Goal G2

Lm|

Link -
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Adding Transformations to AdvoCATE

Alternatively, some or all the transformations can be added to the AdvoCATE main menu and task bar

[n7 Advocate - platform:iresource/td 0.acd#/0 - AdvoCATE =
File Edit View Navigate Searq 1 Window Help
o B e @, ExternalTools » (no launch history) F = e E To% Quick Access = | [E Advocate |
[ Project Explorer 33 B T=8 (8 a T i’ = 0
External Tools Configurations..
I = gbsaa-sc <o Palette

a [ test-project

Organize Favorites. ..

[8] argument-0.acd

|8 argument-0-G5.acd

|8 argument-0--hierarchy acd
4 1= test-project-2

[@ ehdb-pattem.acp

[#] ha-pattem.acp

Regulatory approval of safe
requires compliance to

Reguistions have been base

relgulations.

on an identification of the
relevant hazards

Asgument of
compiiance with
regulations

System A i
‘acosptably

T
Definition of
“scoeptably safe’

=)

r
?  Organize External Tools Favorltes

=
Argument of
hazard

mitigation

Hazard H1 i
mitigated

[ Selact
"} Marquee

(= Connections

To add transformations

select from the
main menu, the
option Run >
External Tools >

" IsSolvedBy

et Organize Favorites
B select Add from

B Assumption the dialog box that
s opens

i 3. Then select all (or
S the desired)

B mSauten transformations
SPaems o from the list.

ehdb-pattern

ha-pattern

® Y=g

i) () (3]

E®

Favorites:
HT
E Add. i Argument by =1y and operating phases.
Remuove
Up
r T
Diown g # ' Add External Tools Favorltes | =]
Select Launch Configurations:
= @ /4 Compute Metrics
Lol | | [@] A Create Narrative
@] A Export CSY
[¥] /A Extract Assumption
[¥] A Extract Evidence
[¥] A Extract Hyperlink
@:, oK | | ol @ M Hazards To Requirements
£ Miniature View 52 [¥] A Requirements To Evidence
[¥] A Reguirements To Strategies
Base ~ Properties = 2
[@] A Task List
MNode :
4 Goal G1
4 Strategy $1 [ Select All | | Deselect All ‘
4 Assumption A1
4 Justification J1
4 Context C1 Y
+ Goal G2 £/ | Ok J [ Cancel |
Link -
4 Is Solved By Is Solved By
4 In Context Of In Context Of
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Launching Transformations

After adding transformations, launch them in one of two ways:

First, select the resource in the project explorer. Then,
1. select from the main menu the option Run > External Tools , then select the desired transformation.

7 Advocate - platform:/resource/test,

‘argument-0.acd#/0 - AdvoCATE

File Edit View Navigate Searc

Window Help

‘ Tl - =R =g ] Q- 5~ IQ External Tools | A 1 Compute Metrics
= = e | A 2 Create Narrative
[ Project Explorer 52 B G=?'> S g A 3 Export CSV
b = gbsaa—s_c A 4 Extract Assumption
“ @ Eilszzzf'lce;t P A 5 Extract Evidence
[8 argument-0-G5 acd A Bt rypa
E arqument-O—hierarchy_acd M 7 Hazards To Requirements
4 = test-project-2 M 8 Requirements To Evidence
[£] ehdb-pattem.acp M 9 Requirements To Strategies
[F] ha-pattern.acp M TaskList
Run As L4
Extemnal Tools Configurations_
Organize Favorites... HE
with the 1.

2. Alternatively, run the desired transformation from the

|n 7 Advocate - platform:/resourceltest-project/argument-0.acd#/0 - AdvoCATE

EIJLI'.|.=|":4 G T0% -

Hazard H1 i
mitigated

Run shortcut on the task bar

Quick Access

5 | [ Advocate |
T |
o Palette I
[ Select

{_i Marquee

= Connections
" IsSalvedBy
" InContextOf
" HiLink

(= Objects 4
HGoal
@ Assumption
= Context

=ha)

File Edit View Mavigate Search Project Run Window Help

= | e

| i G-l -
B Project | A 1 Compute Metrics
& b M 2 Create Marrative
b gbsaa-sc
4 | test-project A 3 Export CSV
[8 argument A 4 Extract Assumption
[8 argument| & 5 Extract Evidence
[S] argument. A 6 Extract Hyperlink
4 & test-project-2 A 7 Hazards To Requirements
[B) ehdb-patt /M 8 Requirements To Evidence
[F] ha-patter . .
/M 9 Requirements To Strategies
A Task List
Run As 4

External Tools Configurations...

Crganize Favorites. ..

[8 argument-0 2

Regultory approval of safe
requires compliance o
relgulstions

=1
Argument of
compliance with
regulations

Regulations have been base
on an identification of the
relevant hazards

[System A is chmpiiant with the r

G2

System A mests
the relevant
regulations

Ep o vt | R e [ S =2 & 0% -

Hazard H1 i
mitigated

HT

——

Quick Access

5 | (E Advocate |

= O

<% Palette [

[; Select

"} Marquee

(= Connections

" IsSolvedBy
~ InContextOf
" HiLink

= Objects B

CGoal

® Assumption
 Context

() Evidence

D Justification
7oA .



Configuring Transformations

Transformations can be configured, so that their output either appears in the Console panel, is written to a specified folder on
disk, or both.



Import and Export
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Importing Other Formats

AdvoCATE can import arguments in the D-CASE and ASCE formats.



Merging Formal Arguments

AdvoCATE can create arguments from the output of formal methods tools (currently just AutoCert).

A This feature will change significantly in future. It will be systematized to include other tools.
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Troubleshooting
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Troubleshooting

« Default workspaces
 What if AdvoCATE opens with all of the panels minimized?

« Workspace corrupted—create projects external from workspace, re-
Import projects

* If you can’t move the nodes—collisions



